... @
DAVINCI RESOLVE 18 Blackmagicdesign @

@]
The Beginner’s Guide to
@ ®
DaVinci
Resolve 18
| .

Expander

Threshold

C ) (

50.0d8 0.0

Download

Free!

Author: Chris Roberts, Simon Hall



This page intentionally left blank.



The Beginner’s Guide to

DaVinci
Resolve 18



The Beginner’s Guide to DaVinci Resolve 18

Chris Roberts and Simon Hall
© 2023 by Blackmagic Design Pty Ltd
Blackmagic Design

www.blackmagicdesign.com

To report errors, please send a note to learning@blackmagicdesign.com.

Series Editor: Patricia Montesion

Editor: Dan Foster

Contributing Authors: Arthur Ditner, Daria Fissoun, and Dion Scoppettuolo.
Cover Design: Blackmagic Design

Layout: Blackmagic Design, Danielle Foster

Notice of Rights

All rights reserved. No part of this book may be reproduced or transmitted in any form by any means, electronic,
mechanical, photocopying, recording, or otherwise, without the prior written permission of the publisher.
For information on getting permission for reprints and excerpts, contact learning@blackmagicdesign.com.

Notice of Liability

Neither the author nor Blackmagic Design shall have any liability to any person or entity for any loss or damage
caused or alleged to be caused directly or indirectly by the information contained in this book, or by omissions
from this book, or by the computer software and hardware products described within it.

Trademarks

Many of the designations used by manufacturers and sellers to distinguish their products are claimed as
trademarks. Where those designations appear in this book, and Blackmagic Design was aware of a trademark
claim, the designations appear as requested by the owner of the trademark. All other product names and services
identified throughout this book are used in editorial fashion only and for the benefit of such companies with no
intention of infringement of the trademark. No such use, or the use of any trade name, is intended to convey
endorsement or other affiliation with this book.

(Mac) and (macOS) are registered trademarks of Apple Inc., registered in the U.S. and other countries. Windows is a
registered trademark of Microsoft Inc., registered in the U.S. and other countries.

ISBN 13: 979-8-9872671-1-0


http://www.blackmagicdesign.com
mailto:learning%40blackmagicdesign.com?subject=DaVinci%20Resolve%2018%20book%20error
mailto:learning%40blackmagicdesign.com?subject=DaVinci%20Resolve%2018%20trainning%20book

Contents

Foreword viii
Acknowledgments ix
About the Authors X £
Getting Started Xii )
Introducing Blackmagic Cloud XVi
1 Editing in the Edit Page 1
Importing a Project and Relinking Media 2 .
Working with the Media Pool 7 g
Building the Timeline in the Edit Page 20
Editing the Sound Bites 22
Inserting the B-Roll 31
Removing and Trimming Timeline Clips 37 <
Using Trim Edit Mode 40 E
Adding the Music 43
Adding the Final Cutaways 46
Shuffle Insert Edits 49
Finessing the B-Roll 50 o
Slipping and Sliding Clips 53 2
Adjusting Pacing 57
Lesson Review 59
2 Audio, Effects, and Titles in the Edit Page 61
Setting Up the Project 62 §
Duplicating the Timeline 62 2
Adding the Voiceover and Sound Effects 64
Mixing the Soundtrack 79
g
5
Contents a




Replacing Shots
Changing Clip Speed
Changing Shot Framing
Adding Transitions
Adding Filters

Adding Fusion Titles

Lesson Review

An Introduction to Color Correction
Why Color Correct Your Work?
The Goals of Color Grading

The Tool Hollywood Uses

Performing Primary Color Corrections
Exploring the Color Page Interface

Using the Primary Corrector

Understanding Video Scopes

Color Correcting Using Lift, Gamma, and Gain
Making Automatic Adjustments
Understanding Nodes

Using Nodes to Separate Corrections
Labeling Nodes

Using DaVinci Resolve Color Management
Adjusting Individual Color Channels

Using Curves for Primary Color Corrections
Using Curves in Separate Nodes

Lesson Review

Contents

94

98

103

109

114

119

125

127

128

130

133

135

136

139

141

144

151

158

159

163

164

169

173

177

183



4 Making Secondary Color Adjustments 185

Masking Areas with Windows 186
Reversing Selections with Outside Nodes 191
Using Windows to Adjust Lighting 192
Making Secondary Adjustments with HSL Curves 197 -
Making Quick Adjustments with the Color Warper 201 -
Selecting Areas with the Qualifier 206
Combining Qualifiers and Power Windows 213
Using the Tracker 216
Applying Resolve FXin the Color Page 219 §
Lesson Review 225 8
5 Grade Management 227
Identifying Ungraded Clips 228
Copying Grades 230
Working with Stills 233 é
Importing and Exporting Grades 239 :
Working with LUTs 243
Making Creative Decisions 251
Lesson Review 253
o
6 Project Setup and Preferences 255 2
Project Settings 256
Importing Clips on the Media Page 261
Viewing Clip Metadata 267
Working with Automatic Smart Bins 269 z
Creating Custom Smart Bins 274 S
Preferences 278
Exploring Keyboard Shortcuts 286
Lesson Review 293
g
5
Contents "6’




vi

An Introduction to Audio Post and Sound Design

What Is Audio Post-Production?

What Is the Audio Post-Production Workflow?

Spotting the Soundtrack

Production Dialogue Editing

Sound Design and Sound Effects Editing
Music Editing

Enhancing and Sweetening Tracks

Mixing and Mastering

Mixing Audio in Fairlight

Setting Up the Project

Exploring the Fairlight Interface

Setting Track Formats and Clip Channels
Trimming Clips in Fairlight

Adding and Aligning Sound Effects
Using Fairlight FX

Mixing the Music

Lesson Review

An Introduction to Visual Effects Compositing

What Is Visual Effects Compositing?
Getting Started with Visual Effects

Learning to See

Contents

295

296

296

297

297

298

299

300

301

303

304

308

313

322

325

334

336

343

345

346

346

350



8 Creating Effects in Fusion 351

The Fusion Interface 352
Adding the First Effect 355
Masking Effects 360

Adding Clips from the Media Pool 365 =

a

Adding An Effect 370 .
Reviewing Work in the Edit 371
Lesson Review 375
9 Delivery and Media Management 377

o

Working in the Deliver Page 378 9

e}

O
Rendering Out a Web Streaming File 378
Creating a Custom Preset 381
Rendering Out Individual Clips 383
Consolidating Media 385

<

Copying Projects and Media to a New Hard Drive 388 a

=
Exporting Timelines, Bins, and Projects 389
Working with the DaVinci Resolve Project Library 391
Creating and Switching Project Libraries 391
Backing Up Project Libraries 393

o

Project Libraries in Blackmagic Cloud 394 S

<
Lesson Review 399
Index 401

=z

o

[72]

2

24

w

=

-

w

Contents o




viii

Foreword

Welcome to The Beginner’s Guide to DaVinci Resolve 18.

DaVinci Resolve 18 is the only post-production solution that combines editing, color
correction, visual effects, motion graphics, and audio post-production all in one software
tool! Its elegant, modern interface is fast to learn for new users yet powerful enough for
the most experienced professionals. DaVinci Resolve lets you work more efficiently
because you don't have to learn multiple apps or switch software for different tasks. It's
like having your own post-production studio in a single app!

DaVinci Resolve 18 adds Blackmagic Cloud support for remote collaboration, DaVinci proxy
workflow, new Resolve FX, intuitive object masking, improved subtitling for editors,
Fairlight fixed bus to FlexBus conversion, and so much more!

Best of all, Blackmagic Design offers a version of DaVinci Resolve 18 that is completely freel!
We've made sure that this version of DaVinci Resolve includes more features than any paid
editing system. That's because at Blackmagic Design we believe everybody should have
the tools to create professional, Hollywood-caliber content without having to spend
thousands of dollars.

Linvite you to download your copy of DaVinci Resolve 18 today and look forward to seeing
the amazing work you produce!

Grant Petty
Blackmagic Design

Foreword
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Getting Started

Welcome to The Beginner's Guide to DaVinci Resolve 18, the official Blackmagic Design
Training and Certification book that teaches editors, artists, and students how to edit,
composite, color correct, and mix audio in DaVinci Resolve. All you need is a Mac or
Windows computer, the free download version of DaVinci Resolve 18, and a passion to
learn and tell your story!

This official step-by-step training guide covers the basics of editing, visual effects, motion
graphics, color correction, and audio so you can start creating your own Hollywood-caliber

film and video today!

— How to mark selections, edit clips in the timeline, and perform context-
sensitive trimming

— How to retime clips, add transitions, and pan and scan photos
— How to work with new title templates, create your own titles, and add animation

— How to perform primary and secondary corrections using DaVinci Resolve’s legendary
color tools

— How to match shots, use color management, create looks, and grade multiple clips
— How to use Power Windows, track objects in a shot, use curves, and add Resolve FX

— How to set up projects, import media, and use metadata to speed up your work

Getting Started



— How to edit and mix audio using the Fairlight audio tools

— How to navigate the Fusion page and use a node-based interface for visual
effects compositing

— How to deliver projects in a variety of formats and share them directly to
YouTube and Vimeo

— And dozens of tips and tricks throughout the book that will transform how you work!

Blackmagic Design publishes several training books that take your skills farther in
DaVinci Resolve 18. They include:

— The Beginner’s Guide to DaVinci Resolve 18

— The Colorist Guide to DaVinci Resolve 18

— The Editor’s Guide to DaVinci Resolve 18

— The Fairlight Audio Guide to DaVinci Resolve 18
— The Visual Effects Guide to DaVinci Resolve 18

Whether you want an introductory guide to DaVinci Resolve or want to learn more
advanced editing techniques, color grading, sound mixing, or visual effects, our certified
training program includes a learning path for you.

After completing this book, you are encouraged to take a 1-hour, 50-question online
proficiency exam to receive a Certificate of Completion from Blackmagic Design. The link
to the online exam can be found on the Blackmagic Design training webpage. The
webpage also provides additional information on our official Training and Certification
Program. Please visit www.blackmagicdesign.com/products/davinciresolve/training

The Celorist Guide to The Editer's Guide fo The Fairlight Audie Guida to The Visual Effects Guide te

DaVinci
Resolve 18

Getting Started

xiii


http://www.blackmagicdesign.com/products/davinciresolve/training

This book supports DaVinci Resolve 18 for macOS and Windows. If you have an older
version of DaVinci Resolve, you must upgrade to the current version to follow along with
the lessons.

NOTE The exercises in this book refer to file and resource locations that will differ
if you are using the version of software from the Apple Mac App Store. For the
purposes of this training book, we recommend that macOS users download and
use the DaVinci Resolve software from the Blackmagic Design website rather than
from the Mac App store.

To download the free version of DaVinci Resolve 18 or later from the
Blackmagic Design website:

Open a web browser on your Windows or macOS computer.

In the address field of your web browser, type:
www.blackmagicdesign.com/products/davinciresolve.

On the DaVinci Resolve landing page, click the Download button.

On the download page, click the button corresponding to your computer’s
operating system.

Follow the installation instructions to complete the DaVinci Resolve installation.

When you have completed the software installation, follow the instructions in the following
section to download the content for this book.

The DaVinci Resolve lesson files must be downloaded to your macOS or Windows computer
to perform the exercises in this book. After you save the files to your hard drive, extract the
file and copy the folder to your Movies folder (macOS) or Videos folder (Windows).

xiv Getting Started
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To Download and Install the DaVinci Resolve Lessons Files:
When you are ready to download the lesson files, follow these steps:
Open a web browser on your Windows or macOS computer.

In the address field of your web browser, type:
www.blackmagicdesign.com/products/davinciresolve/training

Scroll the page until you locate the The Beginner’s Guide to DaVinci Resolve 18.
Click the Part 1 link to download the media. The file is roughly 3.06 GB in size.

After downloading the zip file to your macOS or Windows computer, open your
Downloads folder and double-click R18_Beginner_Guide_Lessons.zip to unzip it if it
doesn’t unzip automatically. You'll end up with a folder named “R18 Beginner Lessons”
that contains all the content for this book.

From your Downloads folder, drag the R18 Beginner Guide Lessons folder to your
Movies folder (macOS) or Videos folder (Windows). These folders can be found within
your User folder on either platform.

You are now ready to begin Lesson 1.

Getting Started XV
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Introducing Blackmagic Cloud

DaVinci Resolve is the world's only complete post-production solution that lets everyone
work together on the same project at the same time. Traditionally, post-production follows
a linear workflow with each artist handing off to the next, introducing errors and
mountains of change logs to keep track of through each stage. With DaVinci Resolve's
collaboration features, each artist can work on the same project, in their own dedicated
page with the tools they need.

Now Blackmagic Cloud lets editors, colorists, VFX artists, animators, and sound engineers
work together simultaneously from anywhere in the world. Plus, they can review each
other's changes without spending countless hours reconforming the timeline.

Simply create a Blackmagic Cloud ID, log in to the online DaVinci Resolve Project Server,
and follow the simple instructions to set up a new project library—all for one low
monthly price!

Once created, you can access this library directly from the Cloud tab in the Project
Manager to create as many projects as you need—all stored securely online. Then invite up
to 10 other people to collaborate on a project with you. With a simple click, they can relink
to local copies of the media files and start working on the project immediately, with all their
changes automatically saved to the cloud.

Enabling Multiple User Collaboration for your project means that everyone can work on
the same project at the same time—edit assistants, editors, colorists, dialogue editors, and
visual effects artists can now all collaborate wherever they are in the world in a way never
before possible.

Now you don't need to buy expensive proprietary storage that needs an entire IT team to
manage! Blackmagic Cloud Store has been designed for multiple users and can handle the
huge media files used by Hollywood feature films. You can also have multiple Blackmagic
Cloud Stores syncing the media files with your Dropbox account so that everyone has
access to the media files for the project.

To find out more about these exciting workflows, visit
www.blackmagicdesign.com/products/davinciresolve/collaboration

Introducing Blackmagic Cloud
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Lesson 1

Editing in the

Edit Page

Making film and video content is a very
creative, exciting, and rewarding
process. But it is also an endeavor that
requires precision and accuracy. The
edit page features a set of powerful yet
easy-to-use nonlinear editing tools
that have been developed over
decades of moviemaking and is a great
next step in your exploration of
DaVinci Resolve 18.

So, whether you are new to video
editing, or you are already a seasoned
professional—the edit page is where
you'll find all the tools you need to tell
your story.

Time

This lesson takes approximately

60 minutes to complete.

Goals

Importing a Project and
Relinking Media

Working with the Media Pool

Building the Timeline in the
Edit Page

Editing the Sound Bites
Inserting the B-Roll

Removing and Trimming
Timeline Clips

Using Trim Edit Mode
Adding the Music

Adding the Final Cutaways
Shuffle Insert Edits
Finessing the B-Roll
Slipping and Sliding Clips
Adjusting Pacing

Lesson Review

20
22

31

37
40
43
46
49
50
53
57
59




Over the next two lessons, you will edit a short trailer for the documentary film Living in the
Age of Airplanes, directed by Brian J. Terwilliger, so you can appreciate some of the thought
processes and happy accidents that often occur in editing suites around the world.

Media Pool - displays clips in Source Viewer - displays Timeline Viewer - displays
the currently selected bin the unedited footage edited clips in the timeline

Bin List - allows you Timeline - allows you to Toolbar - features timeline editing
to easily select a bin place and adjust clips modes, editing functions, and
to view its contents used in the current edit timeline zoom settings

Importing a Project and
Relinking Media

You will begin this lesson by importing a project that has already been set up for you and
contains the clips needed to edit the trailer.

NOTE You will learn more about project settings in Lesson 6.

Editing in the Edit Page



Open DaVinci Resolve to display the Project Manager.

In the lower-left corner of the Project Manager, click the Import button.

Import

Navigate to R18 Beginner Guide Lessons / Lesson 01 folder and select the file

< Ev Ev T Lesson 02 Q

@0

Name ize Kind

P Age of Airplanes.drp 1, DaVinci Resolve Project File

» [ Timelines - Folder

New Folder Cancel m

Importing a Project and Relinking Media 3



NOTE The file extension .drp indicates this is a DaVinci Resolve Project file.
Using project files like this is a good way to exchange projects with other
users, particularly if you're using a local project library. You'll learn more
about project libraries and creating your own .drp files in Lesson 9.

Click Open.

The project is added to the Project Manager for the current project library.

NOTE DaVinci Resolve does not “open” project files directly from your
system. Instead, .drp files are copied directly into the current project library.
Thereafter, any changes to the project are applied only to the copy in the
project library.

Double-click the Age of Airplanes project to open it and, if necessary, click the Edit
page button.

Select Workspace > Reset Ul Layout to reset the edit page workspace to the default
configuration.

Editing in the Edit Page



In the bin list, select the VIDEO CLIPS bin to display its contents.

VIDEC CLIPS

Currently, all the clips in this project are displaying as offline. This means that the link
that was originally established by the project to the media files, when they were
initially imported, has been broken. So, before you can begin editing the clips in this
project, you'll need to relink the clips in this project to their media files on your
computer’s hard drive.

NOTE Media files may often go offline because they've been moved or
renamed on the original storage. To prevent this from happening, once you
have imported the clips, you should leave them in their original locations on
your computer. If you need to move them, you can use the Media
Management tool, which you will learn more about in Lesson 9.

In the top left of the interface, above the media pool, click the Relink Media button.

VIDEO CLIPS
Ny

Relink Media

VIDEO CLIPS

Importing a Project and Relinking Media 5



The Relink Media window appears, telling you how many clips are missing their
media files.

Relink Media

25 Missing Clips

R18 Beginner Lessons

Click the Locate button, and in the file window that appears, navigate to the R18
Beginner Guide Lessons folder and click Open.

< =v B~ T2 R18 Beginner Lessons [ Q
Name ~ | Size Kind

» [7 Lesson 01 --  Folder
~ [ Lesson 02 -- Folder

> T Timelines -- Folder
> 7 Lesson 03 -- Folder
> 7 Lesson 04 -- Folder
> [ Lesson 05 -~ Folder
> 7 Lesson 08 -- Folder
» B Lesson 07 -- Folder
> [ Lesson 08 -- Folder
> 00 Lesson 09 --  Folder
» T Lesson 10 -- Folder
> B0 MEDIA -- Folder

New Folder Cancel m

Resolve will quickly search this folder and attempt to find the matching media files.

Relink Clips

Finding matching media...

Editing in the Edit Page



NOTE If Resolve cannot find the appropriate files, you can initiate a more
comprehensive search from the Relink Media window using the Disk Search
button. Be aware, though, that this search may take much longer if you have
very large hard drives with lots of media files to search through!

Once the clips are found in the R18 Beginner Guide Lessons folder, Resolve will quickly
relink the clips in the project with their appropriate media files, and the clips will no
longer be displayed as offline in the media pool.

Now that the clips have been relinked to their original media files, you can begin exploring
this project.

Working with the Media Pool

The media pool is the place where clips and other project elements such as timelines are
stored and organized. In the edit page, though, there is much more emphasis on accessing
specific clips in different bins.

The bin list is displayed to the left of the media pool. You can access the clips inside each
bin by clicking on a bin at any time.

Working with the Media Pool 7



Select the VIDEO CLIPS bin to see the clips available in this bin.

VIDEO CLIPS

VIDEO CLIPS

You can also organize bins inside other bins.

Click the disclosure arrow next to the AUDIO CLIPS bin to reveal the sub bins called
Music, Sound Effects, and VO (voiceover).

Sound Effects

Sound Effects

You can also display the contents of multiple bins together in the media pool.

Editing in the Edit Page



Select the AUDIO CLIPS bin, and then Command-click (macQOS) or Ctrl-click (Windows)
the VIDEO CLIPS bin to display all the individual clips in these bins.

VIDEO CLIPS, A... ®

v AUDIO CLIPS

VIDEO CLIPS

Despite easily accessing the different bins, the edit page has a much more flexible
approach to finding the clip you're after, using the metadata that's applied to a clip.

In the Smart Bins section of the bin list, click the disclosure arrow next to the

Keywords folder.

Smart Bins

\F\ Keywords
&3

Smart bins are special bins that will automatically collect different clips based on sets
of rules. The Keywords Smart Bin category is an example of a set of automatic smart
bins that appear when you start adding keywords to clips in your project.

Working with the Media Pool 9



Select the Timelapse smart bin. Two clips appear in the media pool because each of
these has timelapse applied as a keyword.

Timelapse

VIDEO CLIPS

Smart Bins

B Timelapse

Click the disclosure triangle for the Custom Smart Bins folder.

This smart bin, called “Good Takes”, was manually created to help further organize the
clips in this project.

Select the Good Takes smart bin to reveal clips that have been marked as a Good Take.

Good Takes

VIDEQ CLIPS

Smart Bins

Good Takes

10 Editing in the Edit Page



NOTE You'll learn more about viewing, adding, and modifying clip metadata,
including adding keywords and marking clips as good takes so you can create and
organize your own smart bins, in Lesson 6.

Being able to effectively review the clips in your project in the source viewer is an
important part of the editing process.

Select the B-Roll smart bin to display the clips tagged with the keyword “B-Roll.”

Move your mouse pointer across the first clip in the media pool,

The clip is automatically previewed in the source viewer.

You can disable audio scrubbing by choosing Timeline > Audio Scrubbing
or by pressing Shift-S.

Continue moving your mouse pointer across the different clips in this smart bin to
quickly preview them.

For more control, you may need to open the clip in the source viewer since live preview
only temporarily displays the clip for as long as your mouse pointer is over the clip in
the media pool.

Working with the Media Pool 1



12

In the media pool, locate the clip to live preview the clip, and then drag
the clip from the media pool into the source viewer.

Now, when you are no longer live previewing a clip, the Kenya clip is displayed in the
source viewer.

You can turn off live preview by clicking the Options menu in the top-
right corner of the source viewer (displayed as three dots), and deselecting
Live Preview.

Live preview the clip in the media pool, and then double-click it to
open it in the source viewer.

The Maldives clip replaces the Kenya clip as the active clip in the source viewer.

To switch back to the Kenya clip, you could reopen it from the media pool or use the
recent clips menu.

Editing in the Edit Page



6 Click the recent clips menu at the top of the source viewer and choose 07 Kenya.mov
from the clips recently opened.

The Kenya clip is reopened.

TIP The source viewer's recent clips menu lists the last ten clips that were
previously opened in the source viewer, with the most recently opened clips
at the top of the list.

Working with the Media Pool 13



NOTE The name of the clip in red indicates that the source viewer is the currently
active part of the interface, so any keyboard shortcuts or menu items will be
applied only to this part of the Resolve interface.

There are different ways you can view clips in the media pool, with options for sorting the
clips depending on your choice. Currently the clips are displayed as thumbnails.

At the top of the media pool, drag the slider to the right to make the
thumbnails bigger.

VIDEO CLIPS

Smart Bins

B B-Roll

When the thumbnails are larger, it's easier to read the clip names.

14 Editing in the Edit Page



NOTE If you're working on a laptop, you may need to increase the overall size
of the media pool by dragging the divider between the media pool and the
source viewer.

Click the Sort menu to display the sort order of the clips.

00:00:28:18

By default, the clips in the media pool are displayed in an ascending order, based on
their clip name.

Working with the Media Pool 15
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Click Duration to change the sort order based on duration, with shorter clips at the top
and longer clips at the bottom.

VIDEO CLIPS

Smart Bins

B B-Roll

Click the List View button.

VIDEO CLIPS

Smart Bins

B B-Roll

Editing in the Edit Page



The thumbnails are replaced by a series of columns displaying various pieces of
information about each clip.

Scroll through the list and notice how the clips are still sorted by duration.

Duration

VIDEO CLIPS

Smart Bins

Click the Duration column header to reverse the sort order, so longer clips are now at
the top of the list and short clips are at the bottom.

Duration

VIDEO CLIPS

Smart Bins

Bl B-Roll

Working with the Media Pool 17



18

Scroll back to the Name column and click its header to reorder the clips based on their
name in ascending order.

Clip Name

VIDEO CLIPS

Smart Bins

Bl B-Roll

Click the thumbnail view button to return to thumbnail view.

VIDEO CLIPS

Smart Bins

B B-Roll

Editing in the Edit Page



The thumbnail view is a good way to live preview the clips quickly, while list view shows
much more information about each clip but doesn't allow you to quickly preview each
clip. To see what each clip is, you'd need to open each one in the source viewer.

Metadata View

A third viewing option in the edit page’s media pool is Metadata view, which is
half-way between thumbnails view and list view.

[ =

2021-08-17 01:00:00:00

e —— 2022-06-28 01:00:00:00
VIDEO CLIPS 3

.
Smart Bins

I 2021-08-17 01:00:00:00

Bl B-Roll

2022-06-22 01:00:00:00

In Metadata view, you have a thumbnail that still allows you to live preview the
clips but also displays some useful metadata fields, such as the names of the clips,
the scene and shot number, and whether the clip is marked as Good.

Working with the Media Pool 19



Building the Timeline in the
Edit Page

Now that you've explored the edit page in terms of reviewing the footage for this project,
it's time to start editing it together into a short trailer. To do that, you will need a timeline.

Because many projects often contain multiple timelines, it's useful to create a bin
specifically to store all the timelines together, making it easy to locate them.

In the bin list, right-click the Master bin and choose New Bin or press Shift-
Command-N (macQS) or Shift-Ctrl-N (Windows).

[ Master

v Master

New Bin

A new bin, called “Bin 6,” is created in the Master bin because it is the sixth bin to have

been created in this project.

]

¥ Master
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With the name of this bin highlighted, type TIMELINES and press Return (Enter) to
rename this bin.

i

¥ Master

Select the new empty TIMELINES bin and choose File > New Timeline or press
Command-N (macQS) or Ctrl-N (Windows).

Change the name of this timeline to Age of Airplanes Trailer and click Create.

Create New Timeline

Create 5
g

TIMELINES

=

Age of Airplanes Trailer

TIMELINES

If you created the timeline in the wrong bin, you can always move it into
the correct bin at any time by dragging it from the media pool onto the
correct bin in the bin list.
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Editing the Sound Bites

As with the previous lesson, you'll begin by editing the interview clips together.

Select the Interview smart bin and open clip in the source viewer.

Click the Go To First Frame button or press the Up Arrow key to return the small
playhead to the start of the clip.

15:51:24:05 ===
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While the edit page supports drag-and-drop editing, it's much more restrictive to what
types of edits you can perform this way, limiting you to the default overwrite edit.
Instead, you can use specific editing functions.

Drag the clip from the source viewer over to the timeline viewer, but don't let go of

your mouse button right away.

An overlay appears, detailing the different types of edits available to you. The default is
Overwrite, which is highlighted automatically.

With the Overwrite option highlighted, release the mouse button.

Your first clip is edited into the timeline, and the timeline viewer becomes active
automatically.
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Click the Full Extent Zoom button so the clip fills the timeline window.

In the timeline viewer, press the Go To Previous Edit button or press the Up Arrow key
to return to the start of the timeline clip. Press the Spacebar to start playback from this
point, and press the Spacebar again to stop playback after Brian says “...shoot the

real world.”

This is where you'll make your next edit.

You can always refine the location of your playhead by using the jog
wheel or pressing the Left Arrow or Right Arrow keys.
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Controlling Timeline Zoom

The edit page has three options for controlling the zoom level of clips in the
timeline: Full Extent Zoom, Detail Zoom, and Custom Zoom.

Full Extent Zoom will always display the whole duration of your timeline in the
timeline window, automatically adjusting the zoom to keep everything in sight.
This is most useful for seeing a bird's-eye view of your edit and allows you to
navigate anywhere within the timeline, like the upper timeline in the cut page.

Detail Zoom scales the timeline to a closer, zoomed view, centered on the

playhead. This option is most useful when you want to step into the timeline to
select a clip or edit point to make fine adjustments, like the lower timeline in
the cut page.

Custom Zoom provides the most flexibility as it allows you to set your own zoom
scale in the timeline. You can use the slider to zoom in and out of the playhead
location or hold Option (macOS) or Alt (Windows) and use the scroll function on
your mouse (or trackpad) to adjust the zoom of the timeline dynamically, centered
on the playhead.

Timeline track heights can be adjusted using the timeline view options menu or by
holding Shift and using the mouse scroll wheel in either the audio or video areas
of the timeline.

Useful keyboard shortcuts for zooming the timeline include:
— Command-= (equals) in macOS or Ctrl-= (equals) in Windows to zoom in to the
timeline playhead

— Command--(minus) in macQOS or Ctrl--(minus) in Windows to zoom out of the
timeline playhead

— Shift-Z toggles between fitting the timeline to the timeline window and
returning you to the previous zoom level
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From the media pool, open in the source monitor.

Go to the first frame of the clip and play through from the start.

You only need to use a part of this sound bite from Brian’s interview. When working
with clips with audio like this, it's useful to see a representation of the audio waveform
along with the video in the source viewer.

You can tell if a clip has audio as well as video by the presence of the
audio symbol displayed in the bottom left of the clip’s thumbnail in the
media pool.

Click the options menu (displayed as three dots) in the upper-right corner of the
source viewer and select Show Zoomed Audio Waveform.

Editing in the Edit Page



An audio waveform is displayed in the source viewer.

How cool is that? Now, as you scrub or play through this clip, you can see from the

waveform where he starts and stops speaking.

Controlling Playback

An important part of editing is learning how to control the playback of your video.
DaVinci Resolve's default keyboard layout supports all the usual shortcuts for
playback that professional editors around the world recognize. You can use the
Spacebar to start and stop playback and the Left Arrow and Right Arrow keys to
move forward and back one frame at a time. More experienced users will be
happy to know that the J, K, and L keys also control playback at different speeds.

The order of the JKL keys match the layout of the Play Reverse, Stop, and Play
transport controls in both the source and timeline viewers.

Try the following to practice controlling the playback of the source or
timeline viewer:

— Hold Kand tap L to jog forward 1 frame

— Hold K and tapJ to jog backward 1 frame

— Hold K and Hold L to scrub forward at half speed

— Hold K and hold ] to scrub backward at half speed

— Press L twice to shuttle forward at twice normal speed

— Press | twice to shuttle backward at twice normal speed

You can keep tapping the J or L keys to increase the shuttling speed up to 64x
normal speed.

Editing the Sound Bites
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Play the clip from the start once more and then stop playback just before Brian says,
“If it was possible to shoot it, we wanted to go shoot it.”

15:54:52:02 ==+

15:54:52:02 #»+
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Play the clip through and stop after Brian says “...everything was real.”

Press O to set an Out point at this location.

00:00:12:11 15:55:04:12  #++

é

Overwrite Clip - F10
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The second interview clip is edited into the timeline starting at the position of the

timeline playhead. The end of the first clip has been overwritten by the new clip.

PRI PaRT PaRT agl Pail fak

NOTE If you're using DaVinci Resolve on macOS, you may need to configure
your keyboard settings in System Preferences to “Use F1, F2, etc. keys as
standard function keys” to use the default editing shortcuts. Alternatively, you
can use the fn key with any F-key to override the macOS shortcuts.

Press the Up Arrow on your keyboard to move your timeline playhead back to the edit
between the two interview clips.

il PRl PaRU ekl Pl b RUPART PRI AT PRI Pakl

e e ———

Choose Playback > Play Around/To > Play Around Current Selection or press /
(forward slash) to review the edit.

The edit is successful enough, but it's a nasty jump cut, which you'll fix in the
following steps.
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Inserting the B-Roll

It's time to add some B-Roll footage to bring Brian's passion for airplanes alive.

Select the B-Roll smart bin and open in the source viewer. Play
the clip from the start to review the footage.

01:00:08:03 ==+
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Press O to set an Out point once the tail of the plane has left the frame.

Fit 00:00:04:06 01:00:12:08 ==+

Ensure your timeline playhead is still on the edit point between the two interview clips
and drag the clip to the Insert overlay in the timeline viewer.

The clip is added in between the two interview clips in the timeline but has been
inserted between them rather than overwriting the clip at the playhead.
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Move the timeline playhead back to the edit between and
. This will be the location for your next edit.

NOTE Using the Up Arrow and Down Arrow keys are fast ways of moving
between the different edit points in your timeline. If you prefer, you can
always drag the timeline playhead, and it will snap to the nearest edit point as
long as your Snapping option is enabled. Press N to toggle snapping on or off.

From the media pool, open in the source viewer. Play the clip
through to review.

This is a nice overhead shot of the same type of plane that you've just edited into the

timeline, but the audio is a little distracting.
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Place your mouse pointer over the source viewer, and then click and drag the video-

only overlay to the Insert overlay in the timeline viewer to insert just the video of
this clip.

NOTE These overlays will allow you to edit only audio and video for the clip in
the source viewer if you are using drag-and-drop editing, or the timeline
viewer overlays. You will learn more sophisticated ways of specifying whether
to edit audio or video only to the timeline, and which tracks to target,

in Lesson 2.

You'll now insert a clip to split an existing clip.

In the timeline, play through the second interview clip and stop after Brian says, “If it
was possible to shoot it, we wanted to go shoot it.” This will be the location for your
next edit.

Open in the source viewer and review the clip.
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Set an In point just before the shadow of the plane starts to pass across the coral.

01:00:39:08 +=+

In the source viewer, type +300 and press Return (Enter) to jump the playhead forward
3 seconds.

+ 03:00| e=e*

Press O to set the Out point.

00:00:03:01 01:00:42:08 *==

Inserting the B-Roll 35



36

NOTE Although you can't set a duration directly in the source viewer, moving
the playhead forward and setting the Out point is the next best solution.
However, you will probably notice that the duration of the marked clip
(represented by the timecode in the upper-left corner of the source viewer)
indicates the duration you have marked is 03:01 (3 seconds and 1 frame). This
is because Resolve sets In points at the head, or start, of the frame, and Out
points at the tail, or end, of the frame. This means the minimum duration you
can mark is 1 frame. If you wish to make sure you are marking exactly 3
seconds, you'll need to move one frame back before setting the Out point. At
this stage though, an extra frame is nothing to worry about.

Press F9 to insert the clip into the timeline at the playhead position.

NOTE If you need to catch up before moving to the next step, select the
TIMELINES bin and choose File > Import > Timeline, navigate to R18 Beginner
Guide Lessons / Lesson 01 / Timelines / and
click Open.
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Removing and Trimming
Timeline Clips

Great. Your edit is starting to come along, and you're now at the stage where you're
probably thinking it may benefit from some refinement.

Move the timeline playhead to the start of the middle interview clip and click the Detail
Zoom button.

Do you notice the small chain icons on the video and audio of this clip? That means
the two parts of this clip are linked. This can be useful if you want to remove or move
both parts of this clip (meaning it would be quite difficult to move them out of sync
with each other, for example).

Click the Linked Selection button in the timeline toolbar.

< é

b
hy

Linked Selection -

With Linked Selection disabled, the linking between clips is ignored.
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Select the video part of the interview clip and choose Edit > Ripple Delete or press
Shift-Delete (Backspace).

The video portion of the clip is removed, and the remaining audio moves nicely under
the preceding shot of the A380 taking off.

Did you notice what else happened in the timeline? Because you performed a ripple
delete, it meant you didn't leave a gap, and the rest of the footage in the timeline
moved up. More to the point, the audio and video in the last interview clip
remained in sync.

Another way to remove sections of clips from your timeline is by using Blade
Edit mode.

Click the Linked Selection button again to enable linked selection for the timeline.

Click the Full Extent Zoom button and play through the last clip on the timeline.

To tidy up this sound bite, you will remove the portion where Brian says “...stay at that
location longer...”
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Play through the last clip on the timeline and stop just before Brian says “... stay...”

Click the Detail Zoom button to zoom in on the playhead location.

] T il Pl (pm T fpu i T il il i
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Blade Edit M

With Blade Edit mode selected, position your mouse at the playhead location and click
the interview clip to add an edit point.

Play forward and stop before he says “..or it didn't make the movie.”

Add another edit point by clicking at the playhead location on the clip.

1
PR

@ INTERVIEW 02.mov

& INTERVIEW 02.mov & INTERVIEW 02.mov
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In the timeline toolbar, click the Selection mode button or press A.

With Selection mode enabled, click the unwanted middle portion of the interview clip
you just added the edit points to.

o

@ INTERVIEW 02.mov

Press Shift-Delete (Backspace) to ripple delete the portion between the In and
Out points.

Press / (forward slash) to preview the new edit.

Don‘t worry if the audio edit isn't quite as tidy as you'd like; you'll have an opportunity to
refine it soon.

Using Trim Edit Mode

The Blade Edit mode isn’t the only mode you have in your timeline to help you refine the
edit. For the next exercise, you'll use the Trim Edit mode.

Click the Full Extent Zoom button to view the whole timeline and move the playhead
back to the beginning of the timeline.

Play through the first clip.

Obviously, there's some unwanted portion of his interview that you need to trim off at
the beginning.
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Place your timeline playhead just before Brian says, “In this film,...”

ﬁ.n . !} ‘. ' .- 7--.‘-;:"'”
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In the timeline toolbar, click the Trim Edit mode button or press T.

Click the beginning of the first clip and drag the edit to the right until it snaps to
your playhead.

& =
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If snapping isn't enabled, just press N to quickly enable it during the
trimming operation.

Notice that because the audio and video of this clip are linked, you're trimming both
parts of the clip together, and because you are in Trim Edit mode, you're automatically
rippling the timeline; all clips in the timeline after the selected edit are rippled to
maintain their sync'd relationships.

You can also use keyboard shortcuts for more precise trimming.
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Place the playhead on the cut between the last two interview clips and click
Detail Zoom.

(1 e RT U a T Rl {RU e fpaRT kT Pail fak
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Position your mouse on the left side of the cut and click to select the outgoing side
of the edit.

Press . (period) twice to add two extra frames to the outgoing clip.

12 E -

-

& INTERVIEW 02.mov
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& INTERVIEW 02.mov

From the waveform, you can clearly see the part of the clip you cut out with the
Blade mode.

Now press , (comma) to trim the same edit point back until the waveform has
disappeared.
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& INTERVIEW 02.mov
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Select the other side of the edit and repeat the process, using the , (comma) key to add
frames to the clip and . (period) to remove frames (because you selected a different
side of the edit).

When you think you have a good audio edit, press / (forward slash) to play around the
selected edit, listening to the changes. Refine if necessary to make the edit sound as
natural as possible.

When you're happy with the edit, click Full Extent Zoom to display the entire timeline
and press A to switch back to Selection mode.

Don't worry if you find these last few steps difficult. Trimming an edit like this so precisely
that it sounds as if there's no edit takes practice, experience, and a good ear. The more you
practice, though, the easier it becomes. Also, because you were in Trim Edit mode
throughout those steps, it meant that the timeline was rippling with each change. In the
edit page, this is only possible if you use Trim Edit mode.

Adding the Music

Now that you've started refining the timeline, you might want to add the music and then
build in the final clips.

Move your playhead back to the beginning of the timeline.

If necessary, use the disclosure arrow to open the AUDIO CLIPS bin, and then select
the Music bin.

Music

Music

There’s just one clip in this bin.
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Open the clip in the source viewer.

10x 00:00:49:14 09:59:30:07 ==+

In the edit page, audio clips are displayed in the source viewer with a waveform at the
top of the whole clip, and a zoomed-in portion below to make seeing the waveform
and adding any required In or Out points easier.

As with the previous lesson, you want to use the whole audio clip, so there’s no need
to add any In or Out points here.

Drag this clip from the source viewer to the Place on Top overlay in the timeline viewer.
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Despite its name, in this instance, the Place on Top edit has actually added a new audio
track below your existing audio tracks. The Place on Top edit actually places the edited
clip into the first available empty track in your timeline, working its way upward
through the video tracks or downward through the audio tracks. If it can’t find an
empty timeline track for the duration of the source clip, then a new track is created to

accommodate the new clip.

You'll need to attenuate (lower) the level of the music clip; otherwise, you won't hear

the interview audio.

Use the volume overlay line on the
clip’s volume by about -18 dB.

-

& INTERVIEW 01.mov 02 A380 TAXL.mov.

Audio 1 " " " . .

& INTERVIEW 01.mov

audio clip to lower the

"f*.l‘ b me

01 A3B0 TAKEOFF.mov 03 MALDIVES.m...

=P

INTERVIEW...

Hold the Shift key on your keyboard when changing audio levels for more

precise adjustments.
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NOTE If you need to catch up before moving to the next step, select the
TIMELINES bin and choose File > Import > Timeline, navigate to R18 Beginner
Guide Lessons / Lesson 01 / Timelines / and
click Open.

Adding the Final Cutaways

Now that you have the music track in the timeline, you need to fill the rest of the time

with more airplane footage.
Move your timeline playhead to the edit point between the last two interview clips.
From the B-Roll smart bin, open the clip in the source viewer.

From the start of the clip, type +200 and press Return (Enter) to jump forward
2 seconds.

Set an In point.

Type +500 and press Return (Enter) and set an Out point.

Fit 00:00:05:01 01:00:07:00 ==+
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Press F10 to overwrite the clip into the timeline.

You're overwriting the video of Brian's final interview clip in the process and neatly
solving the problem of that jump cut at the same time!

From the B-Roll smart bin, Command-click (macOS) or Ctrl-click (Windows) the clips
f ,and

Click and hold any of these selected clips and drag across to the Append at End
overlay in the timeline viewer.
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The three clips are edited at the end of the timeline based on their sort order in the media
pool. However, because they didn't have any In or Out points set, they are currently too
long and need rearranging to make more sense to the story you're trying to convey.

Ensure your timeline is in Selection mode, and then select the three clips you've just
appended to your timeline.

Once the clips are selected, click the Trim Edit mode button or press T to enter Trim
Edit mode.

Right-click the selected clips in the timeline and choose Change Clip Duration or press
Command-D (macQS) or Ctrl-D (Windows).

Change Clip Duration

Change

4 SOUTHP... 05ST MAARTEN.mov 07 KENYA,
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Type 600 in the Duration field and click Change.

The tails (ends) of each of the clips are trimmed so they are all 6 seconds long, and
because you were in Trim Edit mode when you clicked Change, no gaps are leftin
the timeline.

Shuffle Insert Edits

To quickly change the order of these three clips in the timeline, you will use a Shuffle Insert
edit (or Swap Insert edit). You will start by shuffling the Aerial Alaska clip backward.

Press A or click the Selection Mode button to return to Selection mode.
In the timeline, select the last clip,

Press Shift-Command-, (comma) in macOS or Shift-Ctrl-, (comma) in Windows.

05 ST MAARTEN.mov 08 AERIAL ALASKA mov 07 KENYA.mov

The selected clip quickly switches position in the timeline with the clip just before it!

Press Shift-Command-, (comma) in macOS or Shift-Ctrl-, (comma) in Windows again to
have the Aerial Alaska clip shuffle back to before the St Maarten clip.

i |

08 AERIAL ALASKA.mov 05 ST MAARTEN.mov 07 KENYA.mov

Shuffle Insert Edits 49



Select the St Maarten clip and press Shift-Command-. (period) in macOS or Shift-Ctrl-.
(period) in Windows to shuffle it after the Kenya clip.

08 AERIAL ALASKA.mov 07 KENYA.mov 05 ST MAARTEN.mov

Excellent. Now that you have these clips in the correct order, it's time to trim these clips so
the whole timeline is the correct duration.

Finessing the B-Roll

You now need to trim the clips to bring your edit to the correct time, before adding the
credits. To begin with, you will roll the South Pole shot back over the interview to create
more of an overlap.

Place the timeline playhead at the edit point between the Interview clip and the South
Pole clip and click the Detail Zoom button.

If you find the detail zoom makes the clips too big in the timeline, hold
Option (macOS) or Alt (Windows) and use the scroll function on your mouse
or trackpad to reduce the zoom to a more comfortable level.
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Ensure that Linked Selection is turned off and click the Trim Edit mode button
or pressT.

p— -
[ ( .

Place your mouse pointer over the center of the edit point so it displays the trim icon.

Click and drag left to trim the start of the clip back by just over 1 and a half seconds
(about -01:15 in the tooltip) over the previous interview clip, so it starts just after Brian
says the word “...right..." as indicated in the waveform.

04 SOUTH POLE.mov

INTERVIEW 02.mov

Trim the end of the clip back until the gray tooltip reads 04:00,
which indicates a 4-second duration and the timeline ripples.

INTERVIEW 02 mav

Scroll the timeline forward so you can see the Kenya clip clearly.

Trim 1 second off the beginning of the clip to remove the yellow plane
from the top of the frame, tidying up this shot.

‘[ﬂ +01:00

07 KENYA.mov

Next, you will add the closing credits to the end of these clips.
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Click the Full Extent Zoom button so you can see the entire timeline.

Play the last video clip in the timeline and, when you hear the
final beat of music, stop playback.

Click the Titles smart bin and open the clip in the source viewer.

Fit ~ 00:00:09:11 - 01:01:47:11  ==»

LIVING IN THE AGE OF

AIRPLANES

There's no need to add any In or Out points here since you want to use the whole
credits clip.



Click the Overwrite Clip button or press F10 to overwrite the clip in the timeline.

Return the playhead to the start of the timeline and play back to see the results.

The editis looking good, but there are still a few “nips and tucks” you can apply.

NOTE If you need to catch up before moving to the next step, select the
TIMELINES bin and choose File > Import > Timeline, navigate to R18 Beginner
Guide Lessons / Lesson 01 / Timelines / and
click Open.

Slipping and Sliding Clips

Now that you have the edit running at the right time, and the credits appearing on the final
beat of the music, you need to be careful that any trimming you do doesn't disrupt this
timing. This is where Trim Edit mode comes in.

Place the timeline playhead at the start of the Aerial Alaska clip and play until the start
of the credits to review the current clips.

Both the Kenya and St Maarten clips are only using the beginning few seconds of each
clip. To correct this, you will slip each shot to use a later portion of the clip.

NOTE Slipping a clip doesn't mean that you're adjusting the clip’s length in
the timeline; instead, you're moving the content of the clip within the clip on
the timeline.

Slipping and Sliding Clips
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Place the timeline playhead over clip and click the Detailed
Zoom button. Use Option-mouse scroll (macOS) or Alt-mouse scroll to adjust the
timeline zoom if necessary.

Click the Trim Edit mode button or press T.

Position you mouse pointer over the top half of the clip in the timeline, where the
filmstrip is displayed.

05 5T MAARTEN.n ov

The icon changes to the slip symbol.

Click to select the clip and slowly drag the clip to the left.

The timeline viewer switches to a four-up display. The top two images display the start
and end frames for the clip you have selected (St Maarten), and the bottom two
images represent the end frame of the previous clip (Kenya) and the start frame of the
next clip (Credits) in the timeline.
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Continue dragging left until the plane in the St Maarten clip has flown out of shot in
the top right image.

AIRPLANES

You have successfully slipped the clip to refine the portion of the shot you want to use.
You can do the same on the previous Kenya clip.

Hold Option (macOS) or Alt (Windows) and use the scroll function on your mouse to
zoom out on the timeline so you can clearly see several clips.

Scroll the timeline so it is centered around the clip, and then place the
mouse pointer over the Kenya clip's filmstrip to switch to the slip icon.

Click and hold on the clip and slip the clip backward by about 18
seconds (-18:00 in the tooltip) to reveal the part of the clip where the plane flies over a
flock of flamingos.
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Slipping shots like this is very powerful and very intuitive in DaVinci Resolve, as you can
clearly see and understand what is happening as you make changes in the timeline.

Next, you will just refine the position of the Kenya clip in relation to the two clips on
either side of it. To do this, you will slide the clip.

Adjust the timeline scroll and zoom so you can clearly see the

, and clips.

Ensure that you are still in Trim Edit mode and position you mouse pointer over the
clip. This time, though, place it in the lower part of the clip below the
filmstrip and over the bar that displays the clip’s name.

The icon changes shape to the slide icon. This will allow you to slide the clip backward
and forward between its neighboring clips.

Click and hold the clip.
The same four-up display appears in the timeline viewer.
Drag the clip slightly to the left a few frames.

This time, the top two images remain still, but the bottom two images are changing.
This indicates that the clip you have selected is not being affected, but the two clips on
either side are.

Slide the clip back by 1 second (-01:00 in the tooltip).
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Press A or click the Selection Mode button to return to Selection mode.

Play back to review the changes. The Kenya clip lines up much nicer with the beats of
the music. However, it might not be perfect, so continue making further adjustments if
necessary until you're happy with the results.

Trimming Limitations
Whenever you're trimming clips in the timeline, you are relying on the clips having
enough handles—that is, extra footage that will allow you to make the trim.

When trimming, you will see a white outline extend from the clip in the timeline.
This box indicates the amount of extra footage available to you.

If you ever encounter a red selection indicator when trying to trim a clip, you know
that the clip doesn’t have any handles beyond that point, so if the trim you're
trying to make needs this extra footage, you won't be able to make the change.

Adjusting Pacing

One final change you'll make to this edit is to adjust the pacing of Brian's interview slightly
by introducing a small pause.

Move your playhead to the start of the clip.

Play through Brian’s last audio clip and stop just after he says “...it didn't make the
movie” and select the clip.

Press Command-B (macOS) or Ctrl-B (Windows) to add an edit to the selected clip at
the position of the playhead.
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Using this shortcut on selected clips is the same as clicking the clip with
the Blade Edit mode selected, but it's a much more efficient way of adding
edit points.

Select the second of the newly-cut clips in the timeline and drag it to the right until it

snaps to the beginning of

Moving the clip forward a second or so in this manner has created a short space in
Brian's interview that wasn't there originally. This allows Brian's thoughts to "breathe”
and gives an added emphasis to the line about everything being “real”—the equivalent
of punctuation for moviemaking.

Click the Full Extent Zoom button, return the playhead to the start of the timeline, and
play back the timeline to review your hard work.

Well done! You've built a sophisticated trailer using the editing toolset in the edit page.
However, there’s still a few things to do before the director will be happy, and you can call
this edit completed.

In the next lesson, you will continue working on this trailer in the edit page and explore
some of the features used for editing and mixing audio and for adding transitions, effects,
and titles.
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Lesson Review

What element is most often used to organize imported clips in DaVinci Resolve?
Timelines
Thumbnails
Bins

Which zoom function allows you to manually zoom in and out of the timeline?

Full Extent Zoom

Detail Zoom
Custom Zoom

True or false? In the edit page, you can insert a clip by dragging and dropping it at an
edit point in the timeline.

Which timeline mode allows you to add edit points (cuts) when you click on a clip?
Selection mode
Trim Edit mode
Blade Edit mode
Which of the following can be performed when in Trim Edit mode?
Rolling edits
Slipping clips
Sliding clips
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) Bins are most commonly used to organize imported clips in DaVinci Resolve.

¢) Custom zoom allows you to change the zoom around the playhead manually. You
can use the custom zoom slider, keyboard shortcuts, or Option-scroll (macOS) or
Alt-scroll (Windows).

False. In the edit page, drag-and-drop editing only supports overwrite editing functions.

¢) Blade Edit mode adds an edit point when you click a clip. You can add edit points in
Selection mode by positioning the playhead over a selected clip and pressing
Command-B (macQOS) or Ctrl-B (Windows).

a), b), and ¢) You can roll edits and slip and slide clips in Trim Edit mode.
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Lesson 2

Audio, Effects, and

Titles in the Edit Page

Now that you have the basic structure
of the edit in place, you will learn how
to take it to the next level by editing in
voiceover and sound effects, and then
mixing the audio together using the
edit page’s audio tools. Then you'll look
at refining the timeline further by
exploring some tricks that many
editors often employ to quickly replace
shots, adjust clip playback speed, and
change shot size.

There's a wealth of effects to explore
further too, including working with
video transitions and filters and the
library of Fusion title templates.

With so much to explore, it's little
wonder that films are never really
finished; it's just that the filmmakers
run out of time or money or both.

Time

This lesson takes approximately
60 minutes to complete.
Goals

Setting Up the Project
Duplicating the Timeline

Adding the Voiceover and
Sound Effects

Mixing the Soundtrack
Replacing Shots
Changing Clip Speed
Changing Shot Framing
Adding Transitions
Adding Filters

Adding Fusion Titles

Lesson Review
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79
94
98
103
109
114
119
125
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Setting Up the Project

If you completed the previous lesson and are happy with your timeline, you can go to the
next section, “Duplicating the Timeline.” However, if you didn't complete the entire previous
lesson or are unhappy with how your timeline turned out, you can import a prepared
timeline to help you get started with this lesson.

If necessary, open DaVinci Resolve.

In the Project Manager, open the Age of Airplanes project.

NOTE If you didn't complete the first part of the previous lesson and haven't
imported the Age of Airplanes project, refer to the beginning of Lesson 1 to
learn how to import the project file and relink the offline media.

Select the TIMELINES bin and choose File > Import > Timeline.

Navigate to R18 Beginner Guide Lessons > Lesson 2, select the file
and click Open.

The timeline is imported into your project and opens in the timeline window. You can
now continue with this lesson.

NOTE You will learn more about exporting and importing DaVinci Resolve
timelines in Lesson 9.

Duplicating the Timeline

Before going much further, it's always a good idea to periodically duplicate the timeline
you're currently working on. This means that if you (or your client/director) don't like the
subsequent changes you make, you always have a backup copy of the timeline to return to.
It is good practice to duplicate the timeline before you start making major changes.
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In the Timelines bin, select the timeline you've been working
on and choose Edit > Duplicate Timeline, or right-click the timeline and choose
Duplicate Timeline.

TIMELINES J = 2 v *e Y 00:00:00:00

oo

Age of Airplanes Trailer

TIMELINES Duplicate Timelin

A copy of your timeline appears in the same bin called

TIMELINES

Age of Airplanes Trailer

TIMELINES

You can now continue working on the currently loaded timeline, knowing that you
have a backup of your work up to this point.

Many editors often like to rename the duplicated timeline, so they know what they are
looking at in the bin. However, if you leave the name of the duplicated timeline as is,
subsequent duplication of the original timeline will result in the name of the new
duplicated timeline being incrementally increased. For example, duplicating the
timeline again will result in another copy called
. This can be very useful when helping to "backtrack” to a
previous version of the timeline.
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TIP Projects edited over a long period of time can often result in many
dozens of timelines being created. You can use bins to help organize these
duplicated timelines so you always know which timeline you should be
working on. Alternatively, you can always disable a timeline you're not using
by right-clicking the timeline in the media pool and choosing Disable Timeline.
Disabled timelines cannot be opened without first re-enabling them and will
not appear in the timeline viewer dropdown list.

With a backup copy of your timeline in your bin, you can now continue to work on the
trailer. You'll begin by editing the voiceover and some sound effects to the B-Roll
footage to give it more of an impact.

Adding the Voiceover and
Sound Effects

In the previous lesson, when you added the music, you let DaVinci Resolve automatically
create a new track for you. In this instance, you will manually create the new tracks,
choosing where they will be added in relation to tracks already in the timeline.

Right-click anywhere in the timeline track headers and choose Add Tracks.

Video 1 % - = i
@ O M Lmal ' _ : _
Add Tracks... S = ? -

XS

01 A380 TAKEOFF.mov
A1 Audio 1

=l

Ay
INTERVIEW...
A2 Audio 2

Music for Trailer.wav
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In the Add Tracks dialog, change the number of video tracks to 0 and the number of
audio tracks to 2. Ensure that the Insert Position for the new audio tracks is set to
Below Audio 1 and leave the Track Type at Stereo. Click Add Tracks.

Add Tracks

Video Tracks

Audio Tracks

Add Tracks N

The additional audio tracks are added as specified.

Depending on your screen resolution, you may now need to reframe the timeline so
you can see as many tracks as possible.

First, move your mouse over the track divider between the video and audio tracks.
When it changes to a resize indicator, click and drag upward so that you can see more
of the audio tracks.

02 A380 TAXl.mov 01 A380 TAKEOFF.mov 03 MALDIVES.m...

You may also need to further adjust the track heights of the video and audio tracks so
you can see all five tracks together.
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Click the timeline view options menu on the left side of the timeline toolbar. Use the
Track height sliders to resize the video and audio tracks and adjust the track divider
as appropriate.

=

Timeline View Options

=g

Video View Options

e

[t & INTERVIEW 01.mov

S —

Track Height

@ INTERVIEW 01.mov

A3 Audio3

B E——

Music for Trailer.wav

Once you are happy that you're seeing all the timeline tracks, click the Full Extent
Zoom button to ensure that you're seeing the entire timeline.

Before you start editing the audio clips into these new tracks, it's useful to name the
tracks appropriately.

In the track headers on the left side of the timeline, click on the name for Audio 1 to

highlight it and type DIALOGUE to rename the track.

A1 DIALOGUE
El

A2  Audio 2

[

Repeat the previous step for Audio 2, renaming it to VO, short for voiceover.

Rename Audio 3 to SFX, which is short for sound effects.
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Finally, rename Audio 4 to MUSIC, for obvious reasons.

—~ ———

& INTERVIEW D1.mov INTERVIEW...

A4 MUSIC

Music for Trailer.wav

You are now ready to add the new audio clips to their appropriate tracks.

Editing audio clips in the timeline doesn’t differ much from editing video clips, so you will
begin by using some familiar techniques.

In the media pool, click the disclosure triangle for the AUDIO CLIPS bin and select
the VO bin.

This bin contains two audio clips.

Open the first clip, , in the source viewer and play back the clip to
listen to it.

Set an In point at the start of the waveform just before the narrator says, “In the age
of airplanes...” and set an Out point at the end of the waveform where he says “...
once again.”
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You will add this first VO clip using drag-and-drop editing.

In the timeline toolbar, click the Snapping button to disable it.

&

.
X3

Snapping - N

Snapping is useful for quickly aligning clips in the timeline and can be
enabled and disabled by pressing N on your keyboard.

Click and drag the audio clip from the source viewer into the timeline between the first
two clips on the DIALOGUE audio track, but on the VO track. Play back to hear the
narration that occurs between Brian’s sound bites.

01:00:00:00

@ INTERVIEW 01 mov 02 A380 TAXLmaY 01 ASED TAKEOFF.mav O3 MALDIVES.m.. ¢ INTERVL.  D45OUTH PC
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@ INTERVIEW 01 mov INTERVIEW_. @ INTERVIEWOZmov  IN.

Drag-and-drop editing works well, up to a point, but it can be much more efficient to
use the editing functions that you're already familiar with.

Press N to re-enable Snapping for the timeline and position the timeline playhead at
the start of the Kenya clip.

If you prefer to leave Snapping off, you can still use the Previous/Next
Edit buttons to jump to the edit point.

From the VO bin in the media pool, open the clip in the source viewer.
Play the clip to listen to it.
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This is a section of voiceover from the original film that you will repurpose for
the trailer.

In the source viewer, mark In and Out points around where the narrator says “...leave
behind everything you know about airplanes....”

00:00:03:23 01:0Z2:43:11 ==+

Since you want this clip to be edited onto the VO track, you'll need to change the track
destination selection to that track.

In the timeline track controls, drag the red-outlined A1 control (which represents the
audio in the source viewer) down to the VO track (A2). This changes the targeting of
the source audio to the VO track.

Al DIALOGUE I‘ 2 : FORBEE : -
Y

@ INTERVIEW 01.mov

A3 SFX

A4 MUSIC

e —————

Music for Trailer.wav
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Drag the clip from the source viewer to the timeline viewer for an Overwrite edit or

click the Overwrite Clip button in the timeline.

The clip is edited into the targeted track, starting at the playhead position.

In the source viewer, set In and Out points around the last line of voiceover where the
narrator says “...and prepare to see them again - for the first time.”

Click the Overwrite Clip button in the timeline toolbar or press F10, and then play this
section of the timeline with the new voiceover added.

Excellent. With the voiceover added, you can now turn your attention to adding the

sound effects to help bring the B-Roll shots to life.
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In the track header, click the A3 track destination selection to move the red-outlined
A1 button to the SFX Track.

A4 MUSIC

Now that you've specified the destination track, you will now specify where on this
track you will edit the sound effect clips.

In the timeline, select the second clip and choose Mark > Mark
Selection, or press Shift-A.

@ INTERVIEW 01.mov 02 A380 TAX.mav 01 A380 TAKEOFF.mov 03 MALDIVES.m...

D e L Eer—

& INTERVIEW 01.mov INTERVIEW...

In and Out points appear around the selected clip in the timeline, marking where you
want the clip you will edit to start and stop.

NOTE If you Command-click (macOS) or Ctrl-click (Windows) the selected clip
to deselect it, you will see the duration clearly highlighted through
the timeline.

In the media pool, select the Sound Effects bin and open the clip
in the source viewer and click the Go To First Frame button or press the Up Arrow key.
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In the source viewer, type +100 and press Return (Enter) and press [ to add an In point

1 second from the start of the clip.

00:00:06:00

Click the Overwrite Clip button in the timeline toolbar or press F10.

01:00:11:22
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The clip is overwritten to the correct track in the timeline and between the In and Out

points, removing the In and Out points in the timeline in the process.
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NOTE Drag-and-drop editing will not honor the In and Out points in the
timeline because it always uses the duration marked in the source viewer. This
is one of the main advantages of not using drag-and-drop editing if you know
where you want to edit a clip into the timeline.

You will continue to use this technique to keep editing the rest of the sound effects.

Select the clip and press Shift-A to mark the selection.

W | =

03 MALDIVES.m... ¢ INTERVI.. 04 SOUTH POLE.mov 08 AERIAL ALASKA.mov
— bt B crshdot gue T e

@ INTERVIEW 02.mov  IN... INTERVIEW 02.mov

From the Sound Effects bin, open in the source viewer.

Set an In point somewhere in the middle of this clip.

10% 00:00:04:16 01:00:51:16 ==~
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Make an Overwrite edit.

1. e
/.

03 MALDIVES.m... & INTERVI... 08 AERIAL ALASKA.mov
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@ INTERVIEW 02.mov  IN... INTERVIEW 02.mov

SFX 02 Prop.wav

Select the clip clip and press Shift-A.
From the Sound Effects bin, open in the source viewer.

Mark an In point after the audio settles down to more of a drone (after the big
waveform at the start of the clip).

10x 00:00:05:18 01:00:26:02 ==+
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Make an Overwrite edit.

Select the Kenya clip in the timeline and press Shift-A to mark the selection.

From the Sound Effects bin, open in the source viewer.
Listen to the clip and mark an In point where you would like the edited clip to start.

Make an Overwrite edit.

Fantastic. Hopefully, you can see just how efficient it is to be able to target different
portions, and specific tracks in the timeline when you're editing to other timeline clips.
However, there are still some shots that need sound effects, so you will use some
slightly different techniques for these.

Backtiming an edit means you specify where you want a shot to end by just adding an Out
point rather than an In point in the source viewer.

Select the third clip in the timeline and press Shift-A to mark
the selection.

From the Sound Effects bin, open the clip in the source viewer.

Play through the clip until the sound of the jet starts to fade away.
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Press O to add an Out point.

10x 00:00:09:05 01:00:18:00 ===

NOTE For backtimed edits to work, you only need an Out point. If necessary,
you can remove an In point by choosing Mark > Clear In or by pressing Option-I
(macOs) or Alt-I (Windows). Similarly, to remove an Out point completely, simply
choose Mark > Clear Out or press Option-O (macOS) or Alt-O (Windows). To
remove an In and Out point at the same time, choose Mark > Clear In and Out
or press Option-X (macOS) or Alt-X (Windows).

Make an Overwrite edit.

This time, the Out point you set in the source viewer has specified where the new clip
should stop. Pretty neat, huh?
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You can reuse this same sound effect for the final shot before the credits.

In the timeline, select the clip and press Shift-A.

Make an Overwrite edit.

That just leaves one clip left to add a sound effect to.

The Replace edit is slightly different from the editing functions you've become familiar with,
as it primarily uses the positions of the timeline and source playheads to align the edits.

Move the timeline playhead over the clip just before you see the
wings come into the shot in the timeline viewer.

01:00:16:23
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From the Sound Effects bin, open the clip in the source viewer.

In the source viewer, position the playhead over the highest point of the waveform.

10x 00:00:07:02 01:00:43:20 ==+

Drag the audio clip from the source viewer to the Replace option in the timeline
viewer overlay.

Press / (forward slash) to preview the results of this edit.

The sound effect is quickly synced to the action onscreen as the two playhead
positions specified how the clip should be aligned in the timeline. This would have
been much harder to judge if you were manually trying to sync the action by dragging
the clip in the timeline or trying to judge where the In or Out points should be placed.
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You'll use Replace edit again in a later exercise, but it's worth noting that this is one of
the most useful types of edits beyond the usual Overwrite and Insert edits. In fact, it's
so common to use Replace that it is one of only three editing functions available in the
timeline toolbar.

NOTE If you need to catch up before moving on to the next step, select the
TIMELINES bin and choose File > Import > Timeline, navigate to R18 Beginner
Guide Lessons / Lesson 02 / Timelines / and
click Open.

Mixing the Soundtrack

Now that you've got some sound effects in your edit, the whole timeline seems to come
alive, which just goes to prove how important audio is to a successful edit. However, the
sound effects are currently too loud and are drowning out the other audio clips. Time for
some audio mixing!

In the upper-right corner of the interface, click the Mixer button.

The audio mixer opens to the right of the timeline.

Click and drag the left side of the audio mixer to resize it so you can see the controls
for all the tracks in the timeline.

If you're struggling for screen space with the mixer open, click the Media
Pool button in the top left of the interface to hide the media pool.

Return the playhead to the beginning of the timeline and play back, watching the track
meters in the mixer.
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Reading the Audio Meters

Before you make any clip volume adjustments, it is a good idea to know how to
read the meters in DaVinci Resolve, which use decibels full scale (dBFS) scale to
measure the volume of your audio clips. These meters range from a maximum of
0 dBFS down to -50 dBFS. Any audio levels above 0 dBFS are clipped and will
sound distorted, so you must always keep audio levels below 0 dBFS. Although
not a hard and fast rule, tracks such as dialog, sound effects, and music generally
have target dB levels you can use as good starting points.

MUSIC

Clipping Level

Dialogue Target

Sound Effects Target
Music Target

Normal spoken dialogue should average around -12 dBFS on the meter and
remain in the yellow area.

Sound effects have a wider target range because they have such a wide variety,
but in general, try to target sound effects to fall between -10 and -30 dBFS.

Music tends to sound much louder due to its narrower dynamic range. You should
aim to have music tracks set between -20 and -30 dBFS.

These level guidelines are good starting points, but in the end, your ears must be
the final judges of what sounds right.
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Because dialogue is the most important element in any soundtrack (if you can't hear what
someone is saying, then there’s really no point in watching), that's usually a good
place to start.

In this timeline, you have two dialogue tracks: Brian's interview and the VO. Both need to
be at a consistent level, averaging around -12 dBFS on the audio meters. You will start by
normalizing the dialogue clips.

NOTE Normalizing clips doesn't necessarily make them right, since it is based on
the peak level (the loudest point) of the clip, but it is a useful technique for getting
the levels of different clips to be more consistent.

In the audio track headers in timeline, click the Solo buttons for the Dialogue and

VO tracks.

A1 DIALOGUE

s

A2 VO
Lg

There are Mute and Solo buttons in the Mixer too.

Play the timeline again with just the two dialogue tracks playing and watch their audio
meters in the mixer.

Some of the clips are louder than others, with some peaking at about -8 dBFS and
others barely reaching -18 dBFS!

Mixing the Soundtrack
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Drag a lasso across all the clips on the Dialogue and VO tracks to select them.

Right-click any of these selected clips and choose Normalize Audio Levels.

In the Normalize Audio Level window, leave the Normalization Mode set to Sample
Peak Program and the Target Level at -9 dBFS. Change the Set Level to Independent
and click Normalize.

Normalize Audio Level

Normalize

You may be wondering, why choose -9 dBFS when the average levels for
dialogue should be at -12 dBFS? The answer is simple: -9 dBFS is referring to
the peak level, not the average level. The peak level is the highest point in the
audio clip. It is a useful starting point when normalizing dialogue.
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All the selected clips on the timeline change to a slightly darker shade, indicating that
they have been adjusted in some way.

01:00:49:14
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Play the timeline again from the beginning, looking at the audio meters and checking
the levels.

The levels of the clips on the two dialogue tracks are much more consistent now, but
there are still some clips that need fine tuning.

In the timeline, play from the third clip on the DIALOGUE track.

The fourth clip, where Brian says “...or it didn't make the movie...” sounds a little too
loud because the peak level for this clip wasn't as high as the others, so it's been
adjusted more.

Place your playhead over the fourth clip on the DIALOGUE track and Option-mouse
scroll (macOS) or Alt-mouse scroll (Windows) to zoom in on the clip.

To expand the track size, use Shift-mouse scroll.
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Click and drag the volume overlay to lower the audio level back down until the tooltip
reads about 4 dB.

Do the same with the fifth clip on the DIALOGUE track, bringing the clip level down a
couple of decibels, to about 7 dB.

Click the Full Extent Zoom button and play the timeline again to hear the changes and
watch the new levels in the meters.

There's much more consistency between the different dialogue clips now, but there’s
still a problem with the first clip on this Dialogue track because it seems much lower
than it did before the normalization.

Stop playback and return the playhead to the beginning of the timeline.

Use Option-mouse scroll (macOS) or Alt-mouse scroll (Windows) to zoom in on the first
audio clip.

Use Shift-mouse scroll to resize the audio track heights, making it easier to see
the waveform.

Notice the large spike in the waveform at the start of the clip. This explains why the clip

level was lowered when it was normalized. You will correct this by adding a couple of
keyframes to change the level within the clip.
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Option-click (macOS) or Alt-click (Windows) the volume overlay just after the waveform
spike at the start of the clip.

01:00:00:00
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Ared keyframe is added to the volume overlay.

Option-click (macOS) or Alt-click (Windows) the volume overlay again just after the next
part of the waveform to add a second keyframe.

Drag the volume overlay after the second keyframe to increase the part of the
waveform after the keyframes to about 2 dB.

01:00:00:00

@ INTERVIEW 01.mov

Play back the timeline to review the changes and ensure that the audio for the first
track remains at a consistent level.

Click the Full Extent Zoom button and resize the track heights so you can see the
entire timeline again.

Well done. You have successfully set your dialogue levels for this timeline. Now you can
begin mixing the sound effects and music around this.

Mixing the Soundtrack
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Now it's time to turn your attention to the clips on the SFX track. First, you'll want to adjust
the levels and then apply fades.

In the timeline track header, click the Solo button for the SFX track to include it with
the playback with the dialogue tracks.

01:00:00:00

Since these clips are all roughly at the right level relative to each other, instead of adjusting
each clip to the appropriate level individually, you will adjust the level for the entire track.

Begin playing the timeline from the beginning and, in the mixer, lower the SFX track
slider down by about -12 dB so that the meters are bouncing between the -20 dBFS to
-30 dBFS area.

MUSIC
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You can see how much you have adjusted the track level by the small
white value above the track slider in the mixer.

You can still adjust the level of each clip individually in the timeline, so if you feel that a
clip is too loud or too quiet compared to the other clips on the same track, you can
always adjust that clip to bring it in line with the others.

Increase the level of by about 2 dB and
by about 4 dB so that the level of these clips are more
consistent with the others in the track.

Now that you've set the track level for the sound effects, you can start transitioning in,
out and between each of these clips.

Position the playhead over the first clip on the SFX track, ,and
zoom in to the clip using the Detail Zoom button.

Place you mouse pointer over the clip and select the white
indicator in the top-left corner of the clip.

HF VO 1.wav

SFX 01 Jet taxiwav SFX 05 Jet takeoff.v

This indicator is the fade handle for the start of the clip. There is a similar fade handle
in the top right for fading the end of the clip.

Mixing the Soundtrack

87




88

Drag the incoming fade handle to the right by 1 second (+01:00 in the tooltip).

Trim back the start of this clip by about 18 frames so the fade in starts just as Brian
says “...the real world.”

! o Fv

Play back to review the changes.
The fade handles are a very effective and flexible way of fading clips in and out.

Scroll to the middle of the timeline and apply a fade-in to the clip
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Scroll forward and zoom out slightly so you can see the last clip in the SFX track,

Trim the end of this clip to the right as far as it will go and apply a 4-second fade to the
end so that the sound of the plane trails out underneath the credits.

01:00:40:12

The fade handles are great for when you want to fade a clip in or out, but not so useful
if you want to fade between clips on the same track. For that, you will need to add an
audio transition.

Click the Full Extent Zoom button to display the entire timeline.

Click the Effects button in the top left of the interface to open the Effects Library.
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Click the Audio Transitions category and drag and drop the transition

to the edit point between the first and second clips on the SFX track.

NOTE The red icon to the left of the transition name indicates that this is the
standard transition. To change the standard transition, right-click another
transition and choose Set As Standard Transition.

Drag the same transition to the next edit point on the SFX track.
Close the Effects Library by clicking the Effects button again.
You can add multiple transitions at the same time.

Command-click (macQOS) or Ctrl-click (Windows) the three edit points between the last
four clips on the SFX track.

TMALDVE. @ INTE. 04501
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Choose Timeline > Add Audio Only Transition or press Shift-T to instantly add the
current standard transition to the selected points.

01:00:23:11

You can also right-click these selected edit points and choose to add the
standard transition in quarter-, half-, one- or two-second durations.

The cross-fade transitions allow the audio to fade gracefully from one audio clip to
another, rather than cutting suddenly to the next sound.

The last thing you need to do for the audio for this trailer is to add the music track back
into the mix. To do this, you will unsolo all the other tracks to hear how all the elements
mix together.

In the timeline track header, Shift-click the Solo button for any of the soloed tracks,
making all tracks active.
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Play the timeline, listening to how the music integrates with the rest of the mix, and
making further adjustments to the clip or track level as you see fit.

When you're happy with the overall level of the music, you can add a touch of drama
toward the end of the edit, after the narrator’s final words.

In the timeline, place the playhead over the clip and zoom in so
you can clearly see the waveforms of the last few clips.

Using the waveform of the clip on A2 as a guide, Option-click (macOS) or Alt-click
(Windows) the volume overlay for the music clip to add a keyframe, just as the narrator
is saying their final words.

01:00:37:19
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Option-click (macOS) or Alt-click (Windows) the volume overlay again just before the
final beats of music to add a second keyframe and raise the volume overlay after this
second keyframe by 6 dB so the music swells for the credits.
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Click the Full Extent Zoom button, return the playhead to the start of the timeline, and
play to listen to the overall mix, making further adjustments if necessary.

When you're satisfied with the mix, click the Mixer button to close the mixer.

NOTE If you need to catch up before moving on to the next step, select the
TIMELINES bin and choose File > Import > Timeline, navigate to R18 Beginner Guide
Lessons / Lesson 02 / Timelines / and click Open.

The trailer is coming along well, but as always there are some minor tweaks you will want
to make before you can call this project a wrap. To begin with, you will look at replacing one
shot with another and adjusting the speed of a clip to enhance the action. Then you will
add some considered transitions and other effects, before finally adding the titles. So,
there is still quite a bit to do.
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Replacing Shots

Earlier in this lesson, you used the Replace edit to match an audio clip with the onscreen
action. This time, you will use the same function to be able to quickly exchange one shot
for another: either a completely different shot or another take of the same shot.

In the timeline, position the playhead at the start of the clip.

Fit 00:00:49:14

This clip has served you well through this edit, but looking at it objectively, it's not the
most dynamic of shots. It's time to see if there are any more clips that can be used
instead of this.

If the media pool is currently closed, click the Media Pool button in the top left of the
interface to reopen it, and then select the B-Roll smart bin.

Open the clip in the source viewer.

This clip is a nice replacement for the clip.
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In the source viewer, locate a frame where the plane enters the sunlit part of the lake.

Fit 00:00:14:17 01:00:08:02 ===

Replace Clip - F11

Remember, the Replace edit uses the source and timeline playhead locations to complete
the edit. That's why both frames in the source and timeline viewer are now identical.
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NOTE Replace will always ignore any In or Out points placed in the source
clip but will use In and Out points in the timeline. This is useful when you want
to limit the duration of the replaced part of the timeline.

Now you can see just how easy it is to replace one shot with another. You'll do the
same with another clip, but in a slightly more sophisticated manner.

In the timeline, place your playhead over the last clip before the credits,

You will want to try to find a frame in this shot that is recognizable.

Refine the position of the playhead within this clip so that the jet engines of the plane
are centered in the frame.

01:00:38:17

Find In Media Pool

05 5T MAARTEN.mav CREDITS.maov

Audio, Effects, and Titles in the Edit Page



The media pool opens with the original source clip of the St Maarten shot selected.
This process is very useful for finding the original clips used in the timeline, mainly
because other takes for the same material are often located near it.

VIDEO CLIPS

VIDEO CLIPS

05 ST MAARTEN.mov

In the media pool, find the next sequentially named clip, ,and
open itin the source viewer.

This is a very similar shot to the one you've been using in the timeline up until now, but
it has the added drama of having people in the foreground, making for a much more
exciting finale to the main trailer.

In the source viewer, position the playhead at a frame that has the most visual
similarity to the frame shown in the timeline viewer.

Click the Replace Clip button in the timeline toolbar or press F11.

Play the timeline to review the change.
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The clip in the timeline was replaced with the more exciting version, using the position of
the source and timeline playheads and the timeline clip’s duration, making the timing of
the new shot mostly the same as the original. Hopefully, you can now see another reason
why the Replace edit is one of the most used editing functions!

Changing Clip Speed

Another commonly used editing trick is to adjust the speed of a clip to make it play faster
or slower than it was originally shot. This can be used to enhance action in several ways.

In the timeline, select the clip.
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This is a great shot of the red plane flying through the mountains but adjusting the
speed of the clip will make it a little more interesting.

Click the Inspector button in the top-right corner of the interface to open the Inspector.

Age of Airplanes Trailer
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Click the Speed Change section to reveal the speed controls for the selected clip.

Age of Airplanes Trailer 01:00:28:114 ) O Timeline - 0B AERIAI

The Direction options allow you to play the clip forward or backward or to create a
freeze frame of the clip at the position of the playhead. Alternatively, you can use the
Speed % or Frames per Second fields to adjust the playback speed of the clip.

Click the Speed % value field and type 200 and press Return (Enter).

Speed Change

Direction
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The clip is now running at 200% (twice) its original speed, and a speed icon appears
next to the name of the clip on the timeline to indicate a change has been applied to
the playback speed.

TR TR
%) 08 AERIAL ALASKA.mov
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INTERVIEW 02 _mov

Play back the clip in the timeline to review the results of this change.

NOTE The duration of the clip didn't change in the timeline because you
didn't select Ripple Timeline as an option before you changed the speed.

In addition to speeding up a clip, you can also slow down a clip in the same manner.
Select the clip you recently added.

In the Speed Change controls in the Inspector, change the Speed % value to 50.

Speed Change

The clip is now playing back at 50% (half) its original speed. Unfortunately, the clip now
plays by repeating frames because it's now running at just under 12 frames per
second (as indicated in the Speed Change controls). Thankfully, Resolve provides a way
to smooth these types of speed changes.
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Scroll to the bottom of the Inspector and click the Retime and Scaling section to open
the controls.

Age of Airplanes Trailer D O Timeline - 09 LAK

Change Retime Process to Optical Flow for the selected clip and play back the
clip in the timeline to see the results.

Retime and Scaling

Optical flow is a useful process to apply to clips running slower than 100% since it will
attempt to create new frames in between the original, actual frames. In cases such as
this clip, it can work well, but when one object passes in front of another, it can often
result in an undesirable rippling of pixels.
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About Real-Time Performance and the Render Cache

DaVinci Resolve is high-performance software that is optimized to deliver real-
time effects at high resolutions on a variety of workstations. To ensure that your
system is maintaining real-time performance, you can check the GPU and frame
rate playback indicator at the top of the viewers. If the indicator is green, all is well.
However, if it changes to red, this indicates that the available GPU power of your
computer is insufficient for real-time playback, and the frame rate indicator drops
accordingly. Depending on your system specs, this is probably most noticeable
when trying to play back clips with multiple color corrections or a portion of the
timeline with many effects and/or titles.

While DaVinci Resolve includes several options you can employ when your
real-time performance drops, one of the simplest solutions is to enable the
Render Cache by choosing Playback > Render Cache and choosing one of the
three options:

— Off - no render caching takes place, and all timeline clips, grades, effects, and
titles are attempted to be played in real time.

— Smart - automatically caches intensive effects and timeline clips in formats
judged too processor-intensive to play in real time.

— User - allows you to manually specify which timeline clips will be cached,
along with automatically caching all Fusion titles and effects as part of the
Project Settings (see Lesson 6).

Smart is arguably the easiest option to use as it will do much of the work for you,
and you can always manually flag a clip to cache by right-clicking the clip and
choosing Render Cache Color Output.

You can clean up the render cache for the current timeline at any point by
choosing Playback > Delete Render Cache and choosing All, Unused, or
Selected Clips.

Option-R (macOS) or Alt-R (Windows) allow you to cycle between the three render
caching options.
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Changing Shot Framing

The Inspector also contains several Transform controls that you can use to adjust the size,
position, and rotation of a clip. This can be very helpful if you wish to change the shot size
for visual variety.

Move the timeline playhead over the shot of Brian in the middle of the timeline,
between and . Click to select the clip.

Use the scroll function on your mouse or trackpad to zoom out the timeline viewer, so
you can see the sides of the clip easily.

85% +~ 00:00:49:14 01:00:19:05 ) O3
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Click the timeline viewer's onscreen adjustment controls, to the left of the timeline
viewer's jog wheel.

85%  00:00:49:14 : 01:00:19:05 % O

The white box that appears allows you to adjust the Transform controls for this clip.

NOTE You can also use the Transform controls in the Video tab of the
Inspector to make the same adjustments.

Click and drag any of the corner handles to adjust the Zoom values to resize the shot
of Brian in the timeline viewer without changing the aspect ratio of the clip.
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Reframe the shot by clicking inside the box (avoiding the round control handles) and
drag to change the Position X and Position Y controls.

85% 00:00:49:14 01:00:19:05 4 [

When you have successfully reframed this clip, click the Transform onscreen controls
button to turn off the onscreen controls.
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Click the timeline zoom pop-up menu in the top-left corner and choose Fit, or press Z,
to return the timeline viewer zoom to Fit.

01:00:19:05

Place the playhead at the start of the clip and select the clip
to see its settings in the Inspector.

Enable Dynamic Zoom by clicking the toggle control.

Timeline - 06 ST MAARTEN 2.mov
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In the Timeline onscreen controls pop-up menu, select Dynamic Zoom.

Dynamic Zoom

The green box in the timeline viewer shows the starting size and position of the shot,
and the red box shows the ending size and position of the shot.

Click a corner handle for the green box and make it slightly smaller for a tighter
framing at the beginning of this clip.

MAARTEN 2.mov
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As before, click the onscreen controls to disable the controls in the timeline viewer.

120% 00:00:49:14 01:00:35:20 + =]

Play back the clip to see the changes.

The clip now has an additional “camera move” applied that pulls out to follow the
airplane flying overhead.
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Keyframing Animation

If you want more control over how a clip is adjusted over time, you can manually
apply keyframes to the different parameters in the Inspector. Use the small
diamond button to the right of each parameter’s value field in the Inspector to
add a keyframe at the position of the timeline playhead, holding the parameter
values at that point. Move the playhead to a new position in the timeline and
adjust the parameter values further to automatically add a new keyframe. Resolve
will change the parameter value from the first keyframe to the second keyframe
during playback.

Click the Animation Curve button to view and adjust the keyframe graph for any
clip that contains keyframes in the timeline.

Adding Transitions

You should always add transitions to your projects with great care. Transitions should be
inserted with consideration of the story you are telling and should not be used if they
detract from that story. As a wise man once said, “With great power comes great
responsibility.”

Sage advice aside, transitions are a good way to show a change of location or time that
might be a bit too abrupt for your audience if left with just a straight cut.

Position the timeline playhead at the edit point between and
and click Detail Zoom in the timeline toolbar.
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Click the Effects button to open the Effects Library and choose the Video
Transitions category.

Video Transitions

NOTE As with clips in the media pool, and filters and titles in the Effects
Library, transitions can be live previewed.

From the Wipe transitions category, select Edge Wipe and drag it directly to the edit
point between and . Play back the transition to see
the results.

The transition uses the default settings to wipe up from the bottom of the screen,

revealing the incoming clip.
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Select the transition in the timeline, and in the Inspector, change the Duration to 12
frames and the Angle to about -80.

00:00:49:14 01:00:16:04 - Timeline - Transition - Edge Wipe

NOTE Transitions are added at a default duration of 1 second. This can be
changed in the DaVinci Resolve User Preferences, which you will explore
in Lesson 6.

Check the Feather box and increase the border to around 100.

01:00:16:04 =0 [J +++ Timeline - Transition - Edge Wipe
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Finally, press / (forward slash) to preview the selected transition and channel your
inner George Lucas.

As with audio transitions, there is a standard video transition, indicated by the red icon
to the left of the transition. The default standard transition is the humble
Cross Dissolve.

To change the standard transition, right-click another transition in the
Effects Library and choose Set as Standard Transition.

You can also add this standard transition to multiple edit points as you did previously
with the standard audio transition.

In the timeline, Command-click (macOS) or Ctrl-click (Windows) the three edit points
between , , and

T e 300 00 20 i 1 it i
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Notice the red handle on the incoming side of the and
edit. This indicates that there are no handles available at the
start of the clip.

Choose Timeline > Add Video Only Transition.

A warning appears informing you that if you want to continue to add the transition, the
clips with insufficient handles will be trimmed, disrupting all the careful editing you've
achieved so far. To prevent this from occurring, you'll need to adjust the clip to provide
the required handles.

= Add Transitions
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Click Cancel.

Click the Trim Edit mode button in the timeline toolbar, or press T.

Slip the clip backward by at least a second (-01:00 in the
tooltip), but feel free to slip it further if you wish.

01:00:28:07

& osAgl v 07 KENYA.mov
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INTERVIEW 02.mov
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Using a later part of the clip means there’s now plenty of handles on either side for
the transitions.

Command-click (macQOS) or Ctrl-click (Windows) each of the edit points between
) f and
to reselect them.

Choose Timeline > Add Video Only Transition or press Option-T (macQOS) or Alt-T
(Windows) to apply the current standard transition.

You can change the duration of all multiple transitions by Command-
clicking (macOS) or Ctrl-clicking (Windows) each of them in the timeline and
pressing Command-D (macOS) or Ctrl-D (Windows) to open the Change
Transition Duration window.
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Adding Filters

Another common type of effect you can apply to clips are filters to change the look of a
video clip or the sound of an audio clip.

DaVinci Resolve provides several Open FX video filters, along with a series of Fairlight FX.
Position the timeline playhead over the first clip in the timeline and select it.

In the Effects Library, select the Open FX Filters category and scroll down to the
Resolve FX Stylize group.

Select the Vignette filter and drag it to the selected clip in the timeline.

01:00:00:00

The vignette effect is applied to the selected clip with the default settings that darken
the edges of the frame a little too much.

meline - INTERVIEW 01.mov
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You can double-click a filter to apply it to the selected timeline clip(s).

Click the Effects tab in the Inspector to reveal the Vignette effect controls.

Change the Softness value to 0.0 to better see the shape of the vignette.

01:00:00:00 - 1 +=+  Timeline - INTERVIEW 01.mov

01:00:00:00 1 Timeline - INTERVIEW 01.mav.
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The Size slider only allows you to adjust the value to a maximum of 1. To
increase it further, click and drag in the value field, or select the field and type
in the value you desire.

Increase the Softness back up to about 0.4.

Change the Operating Mode to Advanced and change the Center X value to about 0.56
to move the center of the vignette more over Brian's face, subtly drawing the viewer's
attention more toward him.

01:00:00:00 ) [ Timeline - INTERVIEW 01.mov

You now need to apply this same effect to the other time that you see Brian. To do this,
you will copy the filter from the first clip.

With the first clip still selected, choose Edit > Copy or press Command-C (macOS) or
Ctrl-C (Windows).

Scroll the timeline until your see the next clip of Brian. Click the timecode bar to have
the playhead jump over this clip and select the clip in the timeline.

Choose Edit > Paste Attributes or press Option-V (macOS) or Alt-V (Windows).

The Paste Attributes window appears, allowing you to choose which attributes you
wish to paste from to
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Select Plugins and click Apply.

Paste Attributes

INTERVIEW 01.mov

INTERVIEW 02

KeyFrames

= Video Attributes

v

Audio Attributes

Retime Effects

The effects applied to the copied clip are pasted to this clip, with the same settings.

You can now use the controls in the Effects tab of the Inspector to refine the effect for
this clip further.
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Studio Only Filters

If you're using the free version of DaVinci Resolve to work through this book, as
you are live previewing the Open FX filters, you will no doubt come across filters
that bring up the DaVinci Resolve Studio watermark in the viewer. These filters are
only fully available in DaVinci Resolve Studio.

120% 00:00:49:14 01:00:17:15

o 00

=D Ay e | eSOy

You can still apply these filters, but you will see a dialog telling you that you have
reached the limitation of the free version of DaVinci Resolve.

. | You have reached a limitation with DaVinci

oT Resolve
e

If you choose to continue without upgrading, the watermark will continue to
display in the timeline viewer when playing that clip. However, if you open the
same project in DaVinci Resolve Studio, the watermark will disappear.
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Adding Fusion Titles

The final step for this edit is to add a title so that everyone knows who Brian is and all the
different locations featured in the film.

Click the Full Extent Zoom button and move your playhead to the beginning of
the timeline.

In the Effects Library, select the Titles category.

The Titles category lists all the title generators and Fusion title templates.

Place your mouse pointer over any of the title templates to live
preview them.

From the list of Fusion titles, select the template called
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Drag the title to the timeline into the space above the interview clip.

01:00:00:00

The Fusion title gets placed above the first video clip on a new track.
Place the playhead over the title and select the title clip in the timeline.

The controls for this title appear in the Inspector.

01:00:02:00 .

SAMPLE TITLE

You can double-click a title in the edit page to automatically open the
Inspector and adjust the controls.

These controls allow you to adjust the main characteristics of the text within this
Fusion title.
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Place your timeline playhead over it to see the changes as you make them.
In the text box, highlight the “SAMPLE TITLE" text and type BRIAN J. TERWILLIGER.

Adjust the tracking value to about 1.03 to reduce the spacing between the letters.

01:00:02:00 -

BRIAN ). TERWILLIGER

To reset any Fusion title parameters to their defaults, click on the small
gray dot that appears below the slider once you make a change to the
parameter. To reset the entire template, click the Reset control to the right of
the title's name at the top of the Inspector.

Scroll down to the bottom of the Inspector to the Line Controls section.
Change the Type pop-up menu to Horizontal.

Change the color of the left side of the line to a bright shade of yellow.
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Change the color of the right side of the line to a warm orange.

01:00:02:00 - 1 =+ Timeline - Fusion Title - Simple Underline Lower Third

BRIAN ). TERWILLIGER

01:00:02:00
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You will reuse this title, together with the changes you've made throughout the rest of
this trailer for the different locations that will be featured in the film.

Make sure the title clip is still selected in the timeline and choose Edit > Copy or press
Command-C (macOS) or Ctrl-C (Windows) to copy the clip.
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Place your playhead at the start of the clip and choose Edit > Paste
or press Command-V (macOS) or Ctrl-V (Windows).

A copy of the title is pasted over the clip.

NOTE By default, Resolve will paste a clip back into the same track it was
copied from.

Trim the end of the title to the end of the clip.

Select the title and, in the Inspector, change the text in the text box to MALDIVES.

Contrals
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Repeat these steps to paste additional copies of the title over the

and , changing the text of this instance
to ALASKA. Paste another copy of the clip, changing the text to
KENYA, of course.

You can drag a copy of the title from the timeline to the media pool to
save a copy of the edited title for later use in the current project.

NOTE To import a finished version of this timeline that was completed following
the steps in the two previous lessons, select the TIMELINES bin and choose File >
Import > Timeline; navigate to R18 Beginner Guide Lessons / Lesson 02 /
Timelines / and click Open.

Congratulations! You have successfully completed the trailer for Living in the Age of
Airplanes, and along the way you've learned how DaVinci Resolve’s edit page can be used
to build and enhance the edit.

124 Audio, Effects, and Titles in the Edit Page



Lesson Review

Which editing function uses the position of the source and timeline playheads?
Overwrite
Replace
Place on Top

Which function allows you to set the peak level of selected audio clips to a
desired level?

Paste Attributes
Dynamic Zoom
Normalization
Which Retime process can result in smoother playback of speed changes below 100%?
Nearest
Frame Blend
Optical Flow

True or false? DaVinci Resolve Studio effects cannot be applied in the free version of
DaVinci Resolve.

Which term is used to describe an edit that has In and Out points in the timeline but
only an Out point in the source viewer?

Reversed
Backtimed

Append at End
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B. The Replace edit uses the position of the source and timeline playheads.

C. Normalization automatically adjusts the level of audio clips so the peak level is at the
value specified in the normalization dialog.

C. Optical Flow can result in smoother playback for clips at speeds below 100%.

False. Studio-only effects applied in the free version of DaVinci Resolve will display a
watermark.

B. An edit that uses In and Out points in the timeline but only an Out point in the
source viewer is called a backtimed edit.
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An Introduction to
Color Correction

Before you get into the technical side of color correction and learn how DaVinci Resolve's
powerful color correction tools work, it's important to take a moment to understand color
correction and the creative mediumitis.

Color correction is not something you can do by learning the controls of the color
corrector, and it's not something you can do well just using the scopes. It's a highly creative
skill. Just as a good editor can tell a story and bring a dramatic flow to a program, the

colorist evokes an emotion in a viewer via visual manipulation of the image. While it can
take time to learn how to be a top-level colorist, like all creative skills, it never gets boring
because you'll always have something new to learn and a new creative style to explore!

When using DaVinci Resolve, you have the advantage of more than 30 years of color
correction experience. Blackmagic Design pioneered the development of color correction
hardware and software specifically designed to artistically enhance visual images acquired
from film, video, and digital sources. As a result, DaVinci Resolve possesses an incredibly
deep, sophisticated, and efficient toolset for adjusting the look of the clips in your program
and managing these adjustments over an entire timeline.

Furthermore, DaVinci Resolve has continuously evolved thanks to feedback from countless
professional colorists worldwide working at all levels of the film and broadcast industry.
So, the DaVinci Resolve color page has been developed to work the way colorists think.
Still, for all its technological sophistication, it's important to remember that DaVinci Resolve
is merely a tool that requires an artist to realize its full potential. But, of course, that's the
fun part!

The following lessons cover the basics you'll need to learn to begin harnessing the power
of the color page in your own projects—be they feature films, episodic television, web
series, short subjects, spots, promos, or corporate videos. No matter what you work on,
these formats employ the same fundamental grading techniques and the same basic tools;
so, if you're new to the world of professional color grading, don't worry. All rock star
colorists once had to learn these first steps for themselves, and you'll use the
fundamentals you learn here for the rest of your career.
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Gone are the days when high-quality color grading was unaffordable. Blackmagic Design
has put the powerful color tools of DaVinci Resolve within reach of any editor who has a
reasonably capable workstation or laptop. The polish you'll need to achieve world-class
results is only a click away on the color page.

However, before you start getting into the specifics of color, it's important to step back
and consider, what are these tools really used for?

Why Color Correct Your Work?

This is a tempting question, and one that countless producers and directors have asked:
“The program looks fine the way it was shot; why spend the time to color grade it?" It's a
good question in an industry where time is money; if the program you've cut in the edit
page looks fine, why bother grading it?

The answer is because your program won't look as good as it will after being graded.

The process of adjusting the contrast and color of every clip in a program is variously
called color correction, color grading, or just grading. The difference in terminology is
largely superficial, but most experienced colorists prefer “grading” because “correction”
implies that you only adjust things that are wrong, whereas “grading” implies that you're
holding each clip in your program up to a higher artistic standard. A colorist doesn't ask,
“Does this clip look good?” A colorist asks, “Could this clip look better?”

Much has been said about the emotional power of color to shape audience mood, and

everyone would agree that a scene lit by cool blue lighting will have a very different vibe
than one that's lit by warm orange lighting. The greenish tinge of fluorescent fixtures, and
the salmon-hued wash of mercury vapor streetlights each paint the scenes of a show with
different atmospheric feelings that, when done right, add to the narrative and how your
audience perceives it.

Cooler Warmer
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Of course, what these varied illuminants mean depends on the visual palette you develop.
Warm lighting that denotes romance in one film may instead portray roiling, desert-bound
discomfort in another. Their impact depends on the associations that your grading makes
between the visuals and the story. Should this scene seem later in the day? Should the
colors be more subdued? Should the sky be an inescapable presence? You control these
audience perceptions when you exercise subtle control over the picture via color grading.

The important takeaway is that the color page gives you the tools to mold these
associations to suit your needs - intensifying, attenuating, or completely counteracting
their effect, as necessary, to strike the right tone for every scene.

Narrative cinematography is rarely concerned with capturing objectively lit renditions of
locations with perfectly accurate, neutral color and tonality. Instead, truckloads of lighting
instruments and careful art direction manipulate the light and color of the location to make
it look somber, magical, frightening, or sultry. These efforts extend to the grading suite,
where your job is not to portray the world as it is, but the world that the cinematographer

and director want the audience to see.

What the camera saw (left) and what you want audiences to see (right).

Documentary photography may very often be concerned with presenting a supposedly
unvarnished (yet gloriously rendered) look at the world. And yet even this “realistic” look
at the world is a fabrication, since every adjustment you make to improve the visibility of a
subject, enhance the glory of nature, clean up some archival footage, or push the
surroundings of the frame to recede artfully into the background, can be as carefully
thought out and manipulated as any music video grade.

The point is, whether you're making a horror movie, an architectural documentary, a sales
video, or an automotive advertisement, you're using the tools and techniques of color
correction to create a subjective representation of the imagery. The more control you can
exercise over this representation, the larger palette of emotional response you'll have to
draw from.

An Introduction to Color Correction
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If you want to learn and stay competitive, and especially if you intend to work on client
projects rather than your own, it's good to make yourself aware of current styles and
trends. You've no doubt heard that if you want to write, you should read (and write) as
much as you can, and the same holds true for color grading. Watch movies, television,
music videos, and web shorts. And if you're watching television, make yourself watch the
ads. Once you've had a chance to learn the grading controls that DaVinci Resolve offers,
you'll start to see how different looks correspond to adjustments you can make in your
own projects.

Finally, get out into the world and look at other visuals. Flip through fashion magazines, go
to art galleries, take a hike in the woods, and observe. Fill your mind with diverse images
and analyze them to see what inspires you. The more aware you are of other

visual disciplines, the more ideas you'll bring to your own work.

A last issue to consider is the effect that affordable color grading has had on the television
industry. In most current episodic television productions, the visual style is now as good
as in a feature film. This dramatic change in quality has made television programming
better than ever.

An unintended benefit of this change is that top-level feature film actors now move into
television work and back to film with amazing freedom because television no longer looks
like an inferior medium. Also, high-level film crews and facilities can do a wider range of both
television shows and feature films, while still retaining their premium status. It's an exciting
time when you consider the additional increase in the number of distribution platforms for
high-quality work, such as streaming services. The industry is growing more quickly than
ever, which means talented editors and colorists are more in demand than ever!

The Goals of Color Grading

Color correction can be considered the process of choosing which parts of the raw image
data to display to create a pleasing image for the viewer.

The latest generation of digital cinema cameras are almost all capable of either shooting raw
color space image data or at the very least recording RGB image data with a log-encoded
exposure. Doing so preserves the maximum amount of image data for manipulation during
the color correction process. While this is great for flexibility in workflow and for making
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high-quality adjustments, acquiring media in this way forces you to take the extra step of
transforming it into a viewable image for editing and finishing (in much the same way that
film negatives required development and printing to yield a viewable image).

DaVinci Resolve simplifies this task with built-in camera raw controls, DaVinci Resolve color
management (RCM), and LUT support, so you can quickly get your media to a solid starting
point upon which to build the rest of your grade.

SEL& DY

MOLLIE ° -~ MOLLIE °

SEL&DI

Log encoded source (left) and the same source color managed to a deliverable color profile (right).

While the job of the cinematographer is to light and expose the image with an artistic
intent, your job as an editor and colorist is to realize this intent by adjusting the color and
contrast of the image of each clip so the result is as close to the director’s and
cinematographer’s intentions as possible. In the process, you can overcome
inconsistencies with exposure and color balance that were otherwise unavoidable.
Furthermore, you can subtly adjust warmth and contrast to realize looks that were not
achievable during the shoot, but that the director and cinematographer would have liked.

An overexposed image (left) and the corrected image for the audience (right).

Of course, in some situations, you may find it necessary to fix media that has more
substantial problems in color and exposure. In these cases, the tools exist to make far
more involved changes to the image; however, the quality of your results will depend
heavily on the quality and “latitude” of your source media. For example, Blackmagic URSA
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Mini cameras record quite a bit of image data within raw or minimally compressed media
formats, allowing you to make extreme corrections that would be impossible with data
from consumer cameras. Happily, in either case, the color page provides the tools to
process images in many ways to adjust the image to achieve a better look.

While you're doing all this, it's important to keep in mind that for all the creative
possibilities that DaVinci Resolve affords, it's still important that the deliverables you
provide to your client have appropriate signal levels relative to their distribution
requirements. Programs destined for cinema, broadcast, or streaming usually have very
specific outer boundaries of luma, chroma, and gamut that you must not exceed, or you'll
risk having a show kicked back to you for quality control violations.

DaVinci Resolve provides tools specifically designed to help you keep an eye on how the
image data is affected, and to fine-tune the image. In particular, the scopes display the
standard Waveform, Parade, Vectorscope, and Histogram graphs that you can use to
objectively analyze image data. These scopes let you see the boundaries of what's possible
and make it easy to spot subtle problems and compare the characteristics of one image

to another.

It's rare for uncorrected shots to match one another seamlessly. Even the most carefully
exposed angles of coverage can have small variances that should be evened out. For
example, run-and-gun programs using available light often result in edited scenes with
huge changes in lighting and color as one shot cuts into the next.

Small or large, variations between shots can call undue attention to the editing and jar the
audience in ways that distance them from the program. Balancing these differences is
another fundamental task of the colorist. You know you're finished when every shotin a
scene looks like the same time and the same place, and the color and contrast adjustments
you've made flow unnoticeably from one clip to the next.

Of course, it's not all about subtlety and correction. It's often appropriate—when grading
music videos and commercials, for instance—to bring some radical visual style to a piece.
Here, too, DaVinci Resolve provides an abundance of features for manipulating unexpected
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aspects of the image. For example, you can use custom curves to create an illusion of

chemical cross-processing.

Grading an image (left) with several primary and secondary grades to create the look (right).

The Tool Hollywood Uses

If all that isn't enough incentive to plunge forward into the next few lessons, keep in mind
that DaVinci Resolve has become the tool of choice for some of the largest post-production
facilities in the industry, worldwide. And yet, thanks to its accessibility, within the last
several years, DaVinci Resolve has also become the go-to tool for a wide variety of smaller
boutique post companies and individual artists. Considering only projects completed
recently, DaVinci Resolve was used to grade blockbusters like Rocketman and John Wick:
Chapter 3 - Parabellum, along with indie productions such as The Big Sick and A Ghost Story;
not to mention television shows including HBO's Westworld, AMC's The Walking Dead, and
Amazon Prime’s The Marvelous Mrs. Maisel.

Whether you're looking to build a foundation of skills to enter the post-production industry
as a contributing artist, or you want to develop the ability to finish your personal creative
work in your own way, the following lessons will usher you into a much larger world of
image manipulation and artistic expression than has ever been available in the average
nonlinear editing application.

Lastly, color grading is just fun! The feeling of resting your hands on the trackballs and
holding the emotion of your images in your hands is exhilarating. It's like no other feeling
in the world; you can make adjustments in real time, instantly see the results, and feel the
emotional impact in your heart. We believe that color correction is one of those tasks that
is more creative than cerebral. It's also one of those jobs that surprises you every day and
has an emotional connection that reminds us why we fell in love with the film and television
industry in the first place!

Enjoy the journey!
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Lesson 3

Performing Primary
Color Corrections

Like editing, audio mixing, and visual
effects, color correction is an art form
that takes time to learn and master.
Color is an incredibly powerful creative
tool that can define the style and convey
the mood of your film. If you give
yourself the time to practice and learn,
you'll be able to master this exciting skill
and create images that look amazing!

These next three lessons provide a
valuable overview of the most
important color-correction tools to get
you comfortable with how they work.
You'll learn about the primary corrector,
secondary adjustments, nodes, and
even applying DaVinci Resolve FX for
special effects. You'll use the same tools
that Hollywood's top colorists use to
correct and finish the biggest
blockbuster films, episodic television
shows, and commercials. Experience is
key, and with so many controls at your
fingertips, these lessons will give you
the start you need toward learning this
creative skill.

Time

This lesson takes approximately
90 minutes to complete.

Goals
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Gamma, and Gain

Making Automatic Adjustments
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Separate Corrections
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Exploring the Color Page Interface

The exercises in this lesson will teach you how to make color adjustments on clips to
correct commonplace issues like overexposure, low contrast, and incorrect white balance.

All these corrections, along with the creative process of color grading, take place within the
color page in DaVinci Resolve. Let's start by examining the color page layout.

Open DaVinci Resolve to the Project Manager window.

In Lessons 3-5, you'll learn a color-grading workflow using a documentary about
cattle ranchers in the U.S. state of Wyoming. The project you will use was archived
using DaVinci Resolve. An archive is a self-contained project that includes all its media.
All you need to do is restore the archive, and the project will be available with all the
media already linked.

Right-click in the Project Manager window and choose Restore Project Archive.

A Project Archive is a folder that contains the DaVinci Resolve project file
and all the media used for the project. When they are restored, the project will
open in DaVinci Resolve and all the media will be connected automatically.

Restore Project Archive...

RS

Navigate to R18 Beginner Guide Lessons > Lesson 3. Select the Wyoming Cattle Ranch.
dra folder and click Open.

In the Project Manager, open the Wyoming Cattle Ranch project, and then from the
edit page Timelines bin, double-click Primary Grading to load the timeline.
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This timeline has only five clips. All the clips are from a single HD camera.

One of the best aspects of DaVinci Resolve is that editing and color grading are

completely integrated into a single application, so you can easily move between
the two with a single click.

At the bottom of the DaVinci Resolve window, click the Color button to go to the
color page.

NOTE If your Ul layout does not look like the image below, go into the
Workspace menu and choose the Reset UI Layout option.

The gallery includes saved The viewer shows the The Node Editor connects
adjustments that you frame at the playhead’s color corrections, image
can copy to other clips in current position in adjustments, and effects to

the timeline. the timeline. create unique looks.

The left palettes contain The center palettes The lower-right area may

primary adjustments for provide access to curves, display the Keyframes

color, contrast, and RAW Windows, tracking, and Editor, scopes, or a
image processing. keying controls. metadata display.

The timeline is divided into thumbnails
and a mini-timeline.

Exploring the Color Page Interface
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NOTE When you're using DaVinci Resolve on a computer display with a
resolution lower than 1920 x 1080, the left and center panels and buttons
might be consolidated and might not look exactly like the images in

this lesson.

When you switch to the color page, the playhead’s position from the editing timeline
remains the playhead'’s position in the color page timeline. The color page does not
change or alter any cuts or transitions; it just provides a way of looking at your timeline
that's more appropriate for color correction.

Click thumbnail number 02, the second clip in the timeline.

02 18:26:38:05 Vi 03 18:41:49:23

§

[

;’&.pple ProRes 422 HQ
An orange outline appears around the selected thumbnail, and the playhead jumps
to the first frame of that clip.

Below the thumbnail, double-click the Apple ProRes 422 HQ name to switch to viewing
clip names.

The mini-timeline below the thumbnails displays thin bars to represent each clip.
A bar's width is proportional to a clip’s duration. Like the cut page, the mini-timeline
shows all the clips in a timeline.

Press the Spacebar, and the playhead will begin to play through the timeline.

If you leave the timeline playing, you'll notice that the orange highlight around the
thumbnail will jump from clip to clip, so no matter where you are in the timeline, the
clip you're looking at will always be the one selected.

Press the Spacebar again to stop playback.

If a track is disabled in the edit page, it will be dimmed in the color page’s
mini-timeline.

Now that you have a basic understanding of the color page layout, you're ready to make
some adjustments.
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Using the Primary Corrector

The most popular controls for creating different looks and balancing your shots are found
in the primary corrector. Because DaVinci Resolve includes many controls in the primary
corrector, you'll spend much of your time using this palette of tools while you're on the color
page. In this first exercise, you'll make a few adjustments just to get a feel for the controls.

In the timeline, make sure thumbnail 01 is the selected clip.

01 17:38:43:05 02 18:26:38:05

A003_11011738_C006....

The primary corrector is divided into four regions: Lift, Gamma, Gain, and Offset. Each
region is split into the color balance controls for adjusting the tint of the image and the
master wheels for adjusting the tonality or brightness.

Primaries - Color Wheels

0.00 0.00 000 000

The Offset adjusts the overall picture. In this first clip, the rancher’s face and hat are a
bit bright, and the darker shadows do not appear very dark. To make an entire image
brighter or darker, you use the master wheel, located under the color wheel.

Using the Primary Corrector
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Drag the Offset master wheel to the left until the image is not as bright, and the
darkest shadows appear to be black. The red, green, and blue number fields above the
master wheel should end up around 20.00.

Offset

20.00 20.00

This improves the tonal range, but the clip also has a very orange tint to it.

When you encounter the terms tonal values or tonal range, we are talking
about brightness values as if the image were black and white, with no color.

Drag the color indicator at the center of the Offset color wheel toward blue/green until
the Rancher’s hat and skin appear less red.

Offset

Adjustments made in the color balance controls are subtle. In most cases, you are just
moving the indicator a few pixels away from the color you want to reduce.
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To turn the correction you have applied on and off to see the before and after, click the
Bypass button in the upper-right corner of the viewer to turn the grade off.

17:38:43:08

Click the Bypass button again to turn it back on.

Always remember to turn the Bypass back on because it turns off the
grading for all the clips in the timeline.

While these adjustments have been made by what you can see in the viewer,

DaVinci Resolve includes tools that can show exactly what is happening in the image
and therefore give you a better understanding of where corrections may be needed.
This is where the video scopes come in.

Understanding Video Scopes

The correction you just did was performed by looking at your viewer and deciding which
changes were needed. However, this can be quite difficult to do by eye—for example, a
color cast may only be in the brighter areas of the image and not in the entire image. But
how can you determine this? Video scopes can give you information about the clip you're
looking at to help make accurate decisions when grading.

There are several scopes at your disposal: Waveform, Parade, Vectorscope, Histogram, and
CIE chart to check a clip’s luminance, exposure, hue, saturation, and color space.

You will use the Parade scope to help balance a shot.
In the timeline, make sure thumbnail 02 is the selected clip.

In the lower-right window, click the Scopes button on the far right of the toolbar.

Understanding Video Scopes
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Click the disclosure arrow to open the Video Scope dropdown menu.

You can switch between the five different scopes using the menu, depending on what
you want to monitor.

Choose Parade.

You may just want to make your scopes a little brighter in the interface so they can be
seen more clearly.

Click the Settings button.

Parade v

From the Settings menu, drag the Parade slider to the right to make the scopes a little
brighter so you can see them comfortably in the interface.
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Click the Settings button again to close the menu.

Scopes Parade v

The Parade scope graphs each color channel individually. The graph is read from
bottom to top with absolute black at line 0 and absolute white at line 1023. When
balancing shots, the image in the parade, called the trace, should not ideally go below
0 or above 1023. Otherwise, the image will clip—cut off parts of the image data—
and lose detail.

You can switch back to the Keyframes Editor and hide the video scopes
when the scopes aren't needed to free up your graphics card’s processor and
improve playback performance.

Reading the Parade from left to right, each channel corresponds to the image
displayed in the viewer. For instance, the left part of the red, green, and blue trace
corresponds to the image’'s left part. This layout makes it easy to look at the scope and
know exactly which area you are evaluating.
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Color Correcting Using Lift,
Gamma, and Gain

Make sure you have clip number 02 selected.

The clip looks a little dark. Using the Offset master wheel, drag it to the right to raise
the clip so it looks a little brighter. The value should be around 35.00

Now looking at this clip, it appears a little flat with little contrast in the shot. The areas of
the clip that should be near white look gray—for example, our subject’s hat. This is
reflected in the parade. The top of the trace, rather than being close to the top of the
parade, sits well below it. This means the highlights in the image are not bright enough.

Scopes Parade
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Instead of using the Offset controls, you will use the Lift Gamma and Gain controls
to make the adjustments. The Gain control allows you to adjust the brighter parts of
the image.

In the Gain region of the primary color wheels, drag the master wheel right so that the
highlights start to look brighter.

1.03 1.03 1.03 1.03

Using the Parade scope, adjust the highlights so the top of the trace touches the 896
line on the blue channel. The value in the Gain control should be around 1.27

Scopes Parade -
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NOTE The Parade scope has one or two small peak areas that go beyond the
main body of the trace. For now, you don't have to worry too much about
these since they can be corrected later. The important thing is to get the shot
nicely balanced.

The highlights in the image now look better. However, if you take a closer look at the
hat, it still isn't quite white; it has a bluish tint to it. This is reflected in the parade as the
top of the blue channel is higher than either the red or the green channel. This shows
that there is more blue in the highlights, and therefore your whites look blue.

To create pure white using additive colors, you mix an equal amount of red, green, and
blue. A white image would have the red, green, and blue traces completely level along
the top of the Parade scope. Conversely, pure black would have the three color
channels completely aligned at the bottom of the graph.

That being the case, you'll use the Parade scope to make color balancing easier.

NOTE Sometimes the parade may look uneven due to the nature of a shot.
For example, a sunset will have a much higher red channel compared to the
green and blue, simply due to the time of day it was recorded.

Using the gain color wheel, click and drag the center point away from blue, toward
yellow, so the top of the parade traces are approximately level. You can now see that
the blue tint that was in the hat has been corrected.

Parade -

131 1.28 | 113
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If at any point you make a mistake, you can simply reset the controls by clicking the
Reset button in the upper-right corner of each region.

Make the highlights a little brighter again by getting the top of the parade to touch
the 896 line.

The highlights are now starting to look nice and bright with no color cast on them.
However, the shadows still look too gray, rather than black.

Under the Lift region, drag the master wheel left until the green trace touches the 0
line. The luminance, red, green, and blue values above the master wheel should end
up around -0.02

-0.02 -0.02 -0.02 -0.02

xS

Immediately the shot's contrast has improved, and the shadows no longer look gray.
There is a very slight cast in the shadows, and the green trace sits ever so slightly
lower than the red and blue. Without the scopes, this might have been difficult

to pick up.

Color Correcting Using Lift, Gamma, and Gain
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Click and drag the Lift color wheel center point slightly toward the area between green
and yellow to get the bottom of the scopes to line up.

Scopes ELET

Once the traces are level, adjust the brightness a little further using the master wheel
so the traces touch the O line.

Click the Bypass button in the upper-right corner of the viewer or press Shift-D on the
keyboard to show the clip without the correction. Click the Bypass button again to turn
it back off to show the adjustments you have made.

Using these controls, you have now accurately adjusted the clip’s contrast by
controlling where the black and white points sit by using the Lift and Gain controls.
You have also adjusted the color in the highlights and shadows to remove any tint that
may have been present in those areas, rather than using the Offset control that would
adjust the color for all areas of brightness in the clip.

NOTE DaVinci Resolve's viewers are previews that are not intended to be color-
critical displays. For projects that are intended for online delivery or social media,
the viewer output may be suitable. For television broadcast or digital cinema, you
can use a Blackmagic Design UltraStudio or DeckLink card to connect

to a broadcast or digital cinema calibrated display.
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Now let’s look at Gamma.

The master wheel under the Gamma color balance control adjusts the brightness
while maintaining the black and white points that you set previously. In general, once
you set your black and white points, if you feel the image is too dark or too bright, you
can try to correct it using the Gamma master wheel.

We will darken this image a bit.

Drag the Gamma's master wheel to the left to darken the wall to the left of the subject.
The luminance, red, green, and blue values above the master wheel should end up
around -0.05. When dragging this control to the left, the image becomes darker.

Gamma

-0.05 -0.05 -0.05 -0.05

[>

Gamma is sometimes referred to as midtones because it adjusts the middle tonal
range of an image.

Now you may want to warm the skin tone of the subject. As the face is neither
particularly bright nor particularly dark, it would be reasonably safe to assume that its
range is somewhere in the midtones and therefore can be adjusted by using the
Gamma color wheel.

Click and drag the center of the Gamma color wheel toward orange just so the skin tones
start to look a little warmer and the color values read: red -0.04, green -0.05, and blue -0.07.

-0.05 -0.04 -0.05 -0.07
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As you can see, the Gamma control is more subjective. As the colorist, you can decide
if the shot should be brighter or darker, warmer or cooler.

The Lift, Gamma, and Gain controls are not narrow adjustments that change only the
dark, midrange, or bright areas. In fact, their ranges overlap by a considerable
amount. This overlap helps you make more natural, smoother-looking adjustments,
but it also means that you'll need to move among the three color balance controls to
achieve best results because adjusting one control visibly impacts the others.

Go back and select clip number 01 in the timeline.

Right-click anywhere in the node window in the top right of the screen and, from the
contextual menu, choose Reset All Grades And Nodes.

Reset All Grades and Nodes

On your own and using the techniques you have just learned, try to balance the first
shot correctly rather than just using the Offset control.

Adjust the Gain so the highlights are brighter, remove the orange tint in the highlights,
lower the shadows so they look darker, and use the Gamma to make the shot a little
darker so it has more contrast.

Remember not to go too far beyond the top and bottom levels in the
parade, or you will start to lose detail in those areas.
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Making Automatic Adjustments

Now that you have a good understanding of how the Lift, Gamma, and Gain controls work,
you can balance, or normalize, your shots before you start down the path of creating looks
or isolating certain colors or areas. Normalizing shots is often the first part of the grading

process that can remove inaccuracies that may have occurred while filming. Doing this will
unify the shots so applying creative grades later will be easier.

However, what happens if you are unsure of what needs correcting, especially if you are
just starting out with color grading? Or maybe due to time limitations, you just want to
correct shots quickly. DaVinci Resolve provides a range of quick automatic tools to help
you correct shots.

Select clip 03 in the timeline. You can see that the tonal range is quite narrow, and the
same blue cast appears in the highlights

Click the Auto Balance button (the A within a circle) in the upper-left corner of the left
palette window, and the clip’s tonal range and color will balance automatically.

0.00 000 0.00 0.00

NOTE An Auto Balance may not work on every clip in your timeline because it
depends on how the material was shot. For example, with a clip shot in low
light, the Auto Balance may try to make the image much brighter, which you
might not necessarily want.
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As you can see, the Auto Balance has given you a good starting point. However, the

highlights are a bit too high and we're losing some detail in the shot, especially around
the subject’s hair braid.

Using the master wheel in the Gain region, drag the wheel left to bring the highlights
down so that the top of the parade can be seen and the hair has it's detail back. The
values should be around 0.91

The shot still looks a little bright, but the shadows look OK, so click the Gamma master
wheel and drag left to drop the brightness in the shot a little more. The values should
be around -0.05

Gamma

-0.05 -0.05 -0.05 -0.05

[

In the Gamma color wheel, click and drag the center point toward orange to give the
subject a little more warmth. The grade looks the same as the one you did before, but
it has taken fewer steps to get there, thanks to the Auto Grade function.
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Select clip 04 in the timeline.

This clip looks quite dark but also has a heavy color cast on it, which suggests that the
camera may not have been properly white balanced.

NOTE Cameras use white balance to neutralize color casts that may appear
when shooting in certain surroundings. If the white balance isn't set correctly,
the clips tend to have a noticeable tint on them.

DaVinci Resolve provides an option that will allow you to automatically white
balance a shot.

Click the White Balance tool in the upper-left corner of the left palette. You will see that
the mouse pointer changes to an Eyedropper tool.

0.00 0.00 0.00 0.00
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If you accidentally click the White Balance tool, simply press the Esc key
on the keyboard to go back to the default mouse pointer.

Bring the pointer over the viewer and place it over an area that should be white—in
this case, over the top-right section of the hat—and click to select.

The clip will immediately lose its yellow cast as you have identified an area that should
be white, and the software has automatically corrected for this.

Adjust the master wheel in the Gain control to raise the highlights in the shot.

The shot still looks a little dark, so using the Gamma control, raise the midtones until
you are happy with the result. If you need an approximate value, the midtone controls
should sit around 0.03
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Again, using an automatic tool has given you a good starting point that you can add to,
to get a nice even color balance. The final auto grading function will allow you to
automatically set a black point and a white point in a shot.

Select clip 05 in the timeline.

In the upper-left corner above the Lift color wheel, click the black point picker.

0.00 0.00 0.00 0.00

Using this control, you will locate and select the darkest point in the image. It should
be in an area that you think represents absolute black in the shot.

Move the mouse pointer over the viewer.

An RGB tooltip appears next to the point, giving you a brightness value for the pixel
you're hovering over. The values range from 0 (black) to 255 (white). When selecting a
black point, you want the red, green, and blue values to be as near to 0 as possible
without all displaying 0. If all the values display 0, there’s a chance that there is no
brightness information present.

Click the darkest area on the left around the scarf where the RGB tooltip reads
approximately R:015 G:014 B: 015.
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If you need to zoom in to the viewer, position the mouse pointer over the
viewer, and scroll the middle mouse wheel.

Clicking the shadow area identifies it as your darkest black point and adjusts other
pixels accordingly. It also corrects any tint in the black so that no single color channel
dominates in the shadow regions.

Now you'll do the same for the white point. In the viewer, you'll locate a bright point in
the image and select it. The point should not be the absolute brightest point, but rather
an area you think should be soft white. In other words, you do not want to pick the sun in
every outdoor shot but rather the white t-shirt someone is wearing or a white car.

This shot includes a small white area just behind the subject, but you can only see a
small part of it.

Press the Spacebar and play the shot until the subject turns her head and then stop
playback. You now have a bigger area to select.
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At the upper left above the Gain color wheel, click the white point picker.

1.00 1.00 1.00 1.00

Place the picker over the bright area and select it.

Click the Bypass button or press Shift-D to see the original image. Click the button
again or press Shift-D to turn the grade back on.

Using the auto select black point and white point tools has allowed you to adjust the
tonal range of the image quickly and easily by allowing you to decide what should be
black and what should be white in the image.

Adjust the Gain master wheel and bring the top of the parade back into the shot just to
make sure nothing in the image is clipped.

You can see on this clip that some further adjustments may be needed, but rather
than doing them on one node, you'll make further changes on additional nodes.
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Understanding Nodes

The color page uses nodes for multiple color corrections. Instead of stacking color
corrections and effects as layers, you can add as many color correctors and filter effects as
you like using nodes. You can view the nodes as a color correction flowchart for each
individual clip. The clip, or the input, starts at the left, flows through each node, and ends
on the right side of the screen with the corrected image output. Unlike the Fusion page
nodes, each node in the color page is a full DaVinci Resolve color corrector and not an
individual effect that performs only one type of image processing. Think of nodes as
building blocks that allow you to construct your finished grade.

BALANCE CONTRAST

The adjustments you made in the preceding exercises were performed using the first
node, which is provided for you automatically in the Node Editor. As you create more
sophisticated corrections, you can add more nodes that target different parts of the image
or add effects.

With clip 05 still selected, you'll add another node to the node tree. Right-click over
node 01 in the top-right Node Editor window.
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From the contextual menu, choose Add Node > Add Serial. A second node will appear
in the node window.

01 wm

You can tell which node you're working on because an orange outline will highlight the
active node.

Using Nodes to
Separate Corrections

Sometimes, as you balance shots you may decide adjustments are best performed by
separating initial tonal corrections from other adjustments such as pushing contrast into a
shot. This is building on the idea that the first node is the initial balance, and further
adjustments can be made once a shot is balanced correctly.

For this shot, you may want more contrast so that the shadows and highlights are
separated further, but without changing the peak black and white points that you just
selected. For this, you can use the Contrast tool.
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On the node you just created, go into the left palette and place the mouse pointer
over the Contrast parameter and click and drag the number field right to push more
contrast into the shot. Adjust it so that the value reads 1.4 or close to it.

The shot looks a little dark, so place the mouse pointer over the Pivot parameter next
to the Contrast and click and drag the number field left to a value of about 0.2.

To reset any of the parameters, simply double-click the tool label in the
interface and the parameter will reset.

The Contrast tool allows you to push the contrast in your shot without going beyond
the set white and black points that you made with the initial correction. The pivot
essentially changes the point from where the contrast adjustment is made to allow you
to make the image brighter or darker.

The contrast adjustment looks good, but maybe the highlights are just a touch too
bright. Using the Gain master wheel, drop the highlights just a touch to around 0.91.

Rather than Bypass the grade, you now just want to see the before and after of the
contrast adjustment. Click the number of the node in the bottom-left corner to turn off
the node. You will see it turn gray when off.

01 m

Now you will see the shot with just the original balance node on.
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Click the number again or press Command-D/Ctrl-D on the keyboard to turn the
selected node back on.

The advantage of having a second node is that the contrast adjustment is separate
from the initial balance, so if you were not happy with the grade you could simply reset
node 02 and keep the balance on node 01. If everything was performed on a single
node, the time spent getting the balance right would be lost as well.

For this shot you want a more subtle look, so you'll do a slightly different contrast
look. Right-click the mouse over node 02 and choose Reset Node Grade from the
contextual menu.

= -

Reset Node Grade

XS

Make sure node 02 is selected and this time click and drag the number field right and
dial in the contrast until it reaches around 1.1.

Click and drag the Pivot left until it reaches around 0.3. This gives you a more subtle
contrast adjustment.

In addition to dragging the number fields, the values themselves can be
typed in. Simply double-click the parameter value and type in a new one.

Finally, we want to introduce a different color into the shot. Again, we want to do this
on a separate node, so we don't need to alter the other changes we've already made.
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Right-click node 02 and choose Add Node > Add Serial from the contextual menu or
press Option/Alt-S on the keyboard to add a serial node. A third node will appear.

>
01 m

The shot needs a little more warmth in it. The shot already has some red and magenta
colors in it, so it might be a good idea to add a little more.

Make sure node 03 is selected; it will have the orange border on the node.

In the primary color adjustments, position the mouse pointer over the tint parameter
and click and drag the parameter right to add more magenta to the shot. The value
should be around 50.

Click the number or press Command-D/Ctrl-D on the keyboard to turn the selected
node off and on to see the adjustment you made and how it combines with the other
grades you've made.

You can now start to understand how useful nodes are, since they allow you to build your
grades a step at a time without affecting the changes you made previously.
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If you want to know about nodes in more detail, the book The Colorist Guide
to DaVinci Resolve 18 by Daria Fissoun goes into why you use nodes and the
different types of nodes available.

Labeling Nodes

The more adjustments you make on a clip, the more nodes you are likely to need. After a
while, you could have a complex-looking node tree, so it's a good idea to start labeling
nodes to give you an indication of what adjustments may have been done on each node.

Still on clip 05, right-click node 01 and choose Node Label from the contextual menu.

01

Label the node BALANCE and press Return (Enter) on the keyboard to exit the
text entry.

Repeat the process, labelling node 02 CONTRAST and node 03 TINT.

BALANCE CONTRAST

01 mi
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Now you have a good idea of which grade is on which node, so you can make an
adjustment on the correct node at any time—for example, changing the overall color
to a cooler look can be done on the TINT node.

Using DaVinci Resolve
Color Management

So far, we've had it fairly easy in our color-grading process. We worked with a few controls

and made the HD clips look better. In your projects, if all you ever deal with is HD clips and
output them as HD masters, then you can essentially continue with the process we started
in this lesson.

However, filmmaking is technical and at times complicated. Few aspects of the process
illustrate this as well as cameras and their various file formats. Each camera manufacturer
tries to give you the best-looking image possible by customizing the color palette (Gamut)
and tonal range (Gamma). You'll often hear these types of clips referred to as log clips due
to their logarithmic contrast profiles. The result of recording log clips is that they don't look
great on your HD monitor. When using different log clips from different cameras in a single
project, you need to manage various gamuts and gamma ranges more efficiently to
achieve consistency in your final output. That's where DaVinci Resolve’s color management
(RCM) helps.

Above the viewer, click the dropdown arrow next to the timeline name to reveal all the
project’s timelines.

Primary Grading v 01:01:02:12

Choose the Color Managed timeline.

This project contains the HD clips we had in the previous timeline and adds new
Wyoming scenery clips. The new scenery clips have an HDR gamut and gamma, having
been shot with a digital cinema camera.
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NOTE These clips were originally captured with a Blackmagic Pocket 4K
digital cinema camera but have been modified for downloading and
teaching purposes.

In the timeline, click the second thumbnail.

Like many clips from digital cinema cameras, these scenic log clips are not intended
to look perfect on an HDTV. Although they have a wide tonal range and a wide color
gamut, they look flat and under saturated. Your HD monitor (or computer monitor) is
expecting HD clips, so it has no idea how these digital cinema camera clips should
look. Resolve color management (RCM) is the easiest and most accurate way to unify
different clips from different cameras, so they all match your desired output.

Click the Project Settings icon in the bottom-right corner of the screen.
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Select the Color Management category from the window that pops up.

Project 5ettings: Wyoming Cattle Ranch

Color Space & Transforms

In the Color Science dropdown menu, choose DaVinci YRGB Color Managed.

Color Space & Transforms

DaVinci YRGB

ci YRGB Color Managed

Enabling color management presents a new dropdown menu below the Color Science
menu. By default, Automatic color management is turned on. This preset menu
contains two settings, either SDR or HDR, which can be chosen from the Color
processing mode menu. SDR is the choice for standard dynamic range, HD (high
definition) source media, and output. The media in our timeline is a mix of log HDR
(high dynamic range) source media and HD media.

The automatic color management shows only a few options for
processing and output. If you cannot find the setting you require, uncheck
the Automatic color management option to see the full range of processing
modes and color outputs.
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In the Resolve Color Management Preset dropdown menu, choose HDR.

Color Space & Transforms

Although this preset is still targeting HD output, it is the best choice when using a mix
of log and HD clips because it preserves the super bright highlights contained in HDR
source media.

The output color space should be set for your final output delivery. Because our
project will be output to HD, we'll leave this menu set to SDR Rec709. This is the
standard setting for HD video.

Click Save to close the settings but keep an eye on the viewer.

You can change the output color space at any time when you are

delivering to different display devices. This is one of the main benefits of
using a color-managed workflow.

Using DaVinci Resolve Color Management
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When using DaVinci Resolve color management, some source clip formats like RAW
files, as well as some QuickTime and MXF wrapped files include information about the
color gamut and gamma. If these metadata tags are present in the files, RCM can
automatically read it and automatically apply the correct settings for the source clips.
This is the case with the clips we have now. They are all tagged and color managed,
so now they look brighter and more colorful on our HD monitor or computer screen.

However, you will likely have some content that does not include the metadata tags,
so let's walk through how you might manually set the Input Color Space for source
clips that are not set automatically.

Adding the Input Color Space as a media pool column will display the
currently assigned color profile for each clip, whether it is assigned by you
manually or automatically by metadata.

Typically, you want to change the Input Color Space value to match the device that
recorded the imported clips. By default, a REC.709 Gamma 2.4 setting is applied to
clips without metadata. This is probably suitable for your HD recorded clips, but you
will come across other formats.

When you have clips without metadata tags, you can manually set those clips
individually from the timeline or in groups from a bin.
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Click the first clip in the timeline. Because this is a graphic, DaVinci Resolve is not sure
how to interpret this file, so we need to tell the software how to read it correctly.

Graphics are usually created using the sRGB color space. You can set the Input Color
Space for any clip directly from the color page timeline.

Right-click the thumbnail in the timeline and choose Input Color Space > sRGB.

Note that you have not color corrected these clips, although they may appear better. If the
clips were shot overexposed, they will appear overexposed. If they were shot with the
incorrect white balance, they will display incorrect white balance. All you have done is
correct the different gamma curves and color gamuts, so they are uniformly set to suit
your HD display device and file output. From here, you can use the techniques you learned
earlier to correct contrast, white balance etc. in the color managed workspace.

NOTE You may notice the grades from your Primary color correction timeline now
look different. These were graded without color management, so when placed in
color management the grades may differ slightly. Turning off the color
management will make these grades look correct again.

Adjusting Individual Color Channels

A lot of the power in DaVinci Resolve comes from the flexibility of its toolset, which
provides many ways to do the same thing. To learn more about the primary corrector
toolset, you'll explore another method for creating a balanced correction on a new shot.

Adjusting Individual Color Channels

169



170

Still in the Color Managed timeline with color management turned on, select clip 02.

00:00:00:00 V 02 08:39:42:00

Y

A011_11080839_C001_...

The clip requires a tonal and color balance, but instead of using the color wheels and
master wheels, we'll use the individual number fields for luminance, red, green, and
blue below the Lift, Gamma, and Gain to make fine-tuned adjustments.

These controls allow you to make color and luminance adjustments similar to the
master and color wheels but provide explicit red, green, and blue controls and
separate luminance adjustments in the Lift, Gamma, and Gain regions. That being the
case, you may find them more effective tools for balancing specific color channels in
different regions of a shot. For tonal adjustments, the Y, or luminance bar, allows you
to adjust luminance without changing saturation.

The image has low highlights as well as slightly raised shadows that can be confirmed
in the scopes. Let's start by setting our black point.

In the Lift region, drag the Lift Y number field to the left until the bottom of the green
and blue traces in the parade touch the 0 line, with the value at around -0.01.

You can see the red channel is a little clipped off the bottom, so let's rectify that.
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Drag the Red number field to the right to level off the bottom of the parade. This
needs only a slight adjustment until the bottom of the traces are level.

Scopes Parade v

&

-0.01 0.01 0.00 0.00
+—r

The darker areas of the image now look better, so we can go ahead and adjust the
brighter parts.

In the Gain region, drag the Y parameter right until the top of the traces sit just above
the 896 line and the value is around 1.35.

135 1.00 1.00 1.00
+—r

The shot certainly looks brighter now; however, it looks a little too warm, and again
looking at the parade you can tell this by the fact that the traces are not level
at the top.
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In the Gain blue number field, drag the parameter to the right until the tops of the
parade traces line up and the shot looks cooler.

Gain

1.35 1.00 1.00 1.12
-—

We could go a step further by adjusting the midtones. Remember that midtones are
more subjective and are quite difficult to measure on a scope, so this can be can be
your judgment call on what you want to do on the shot.

If you feel you want the shot to be brighter, giving the shot a more early-morning,
colder feel, raise the Y parameter in the Gamma region so the shot gets brighter
without clipping.

If you want to give the shot a more afternoon feel with darker, longer shadows, adjust
the parameter the other way.

Morning look Afternoon look

Choose Bypass or press Shift-D to see the original image and then press Shift-D again
to see your grade.
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Using Curves for Primary
Color Corrections

In this exercise, you'll look at the last method of creating a balanced shot. Using the custom
curves, you'll have the greatest degree of flexibility for making tonal and color
adjustments, but this also requires a bit more finessing.

Select clip 04.

Looking at the image, you might not be able to tell that there isn't a lot of contrast, but
looking at the scope, you can see how the trace is all bunched up in the middle of the
graph. This is a common trace appearance for low-contrast images.

Scopes Parade
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You will approach this shot in the same way you did the previous shots: correcting
black point, white point, and color.

NOTE On computers with lower screen resolution, you might have to click
the Curves button to display the curves palette.

The custom curve graph is a plot graph in which you can perform incredibly flexible
adjustments on specific tonal ranges of images. The X axis represents the image’s
tonal values going from the darkest shadows on the left to the brightest highlights on
the right. Along the Y axis are the output, or offset, values with darker adjustments
placed lower in the graph and brighter adjustments placed higher.

Curves - Custom

In the color page, each clip has its own undo/redo history. Choosing
Edit > Undo will undo different steps depending on which clip is currently
selected.

The trees’ shadows should be fairly dark but arguably not completely black, so we will
set the black point in the custom curve accordingly.

Position the mouse pointer over the control point located in the lower-left corner of
the custom curve graph.

This point is the black point control. Like the Lift master wheel in the primary corrector,
adjusting this point raises or lowers the black pointin a clip.
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Drag the point to the right until the trace in the parade is midway between the 0 and
128 lines.

Moving the black point to the right darkens the darkest parts of the image.

Position the mouse pointer over the control point located in the custom curve graph’s
upper-right corner.

This point is the white point control. Like the Gain master wheel, adjusting this point
raises or lowers the white pointin a clip.

The highlights in this shot are fairly dull and could use some brightening.

Drag the point to the left until you have 